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PIO INCIDENT ORGANIZER 
Available online at https://tinyurl.com/pioincidentorganizer Updated April 15, 2025 

 
BREAKFAST HOURS: LUNCH:  DINNER:  SHOWERS: 

  
DAILY SCHEDULE 
 

AM BRIEFING 
 

OPS UPDATE VIDEO 
 

PIO AM MEETING   
 

DISTRIBUTE AM UPDATE 
 
 PRESS CONFERENCE 
 
 PIO COOPERATOR CALL 
 
 COOPERATORS MEETING 
 
 C&G MEETING 
 
 PRE-PLANNING MEETING 
 
 PLANNING MEETING 
 
 PM BRIEFING 

 
COMMUNITY MEETING 
 
DISTRIBUTE PM UPDATE 

 
PIO PM MEETING 

 
 
 

 
PIO Briefings 

Situation: Here’s what I think we face. 

Task: What is to be done. 

Purpose: Why is it to be done. 

End State: What should it look like when 
done. 
 

Concern: Here’s what we should keep our 
eye on because if that changes, we’re in a 
whole new situation. 
 

Calibrate: Now talk to me. Tell me if you 
don’t understand, cannot do it, or see 
something I do not. 
 
 
PIO Pulse Check 
- What have I missed? 
- What is unclear? 
- What must change? 
- Did I learn something others should 
  know? 
- Who’s acting if the lead is unavailable? 
- Do PIOs have regular communication with 
  ICP? 
- Are PIOs aware of incident-within-an- 
  incident procedures? 
- Regular communication with host unit / 
  key contacts? 
- Adequate meals / showers / breaks / 
  work-rest ratio? 
- Are we learning from our mistakes?

 

NAME O-# 

INCIDENT NAME INCIDENT # 

HOST UNIT ACCT CODE 

FIRE INFO # INFO CENTER HOURS 

X/TWITTER FACEBOOK 

https://tinyurl.com/pioincidentorganizer
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NOTES 
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CALL-OUT / CHECKIN / SETUP 
 
UPON CALL-OUT 
- Notify Supervisor 
- Obtain Resource Order 

- Incident name? 
- Report location? Report date and time? 
- Rental car, laptop, camera, printer 

radio and/or cell phone authorized? 
- Contact number for lead PIO and/or 
  Expanded Dispatch at the incident? 
- Copy of Resource Order to home unit 

- Obtain Travel Authorization 
- Call lead PIO with Est. Time of Arrival 

and provide FireNet or Guest Email 
- If virtual ask time zone, start/stop time, 

meeting schedule, section lead contact 
https://tinyurl.com/piovirtual 
 

LEAD IMT PIO 
- Call IC for initial briefing 
- Call unit PAO(s) to assess needs 
- Submit order for PIOs 
- Communicate with incoming PIOs 
- Confirm FireNet Incident Request (p.34) 

with PSC or ITSS 
 

ALWAYS PACK Max weight 65 lb total 
- Resource Order 
- Red Card 
- Federal PIV ID and/or Team ID 
- Task book 
- Incident Response Pocket Guide (IRPG) 
- Cell phone and charger (if authorized) 
- Home Unit Dispatch Phone # 
- Home Unit Timekeeper Phone # & Email 
- Full PPE 
- Personal Gear 
- PIO Travel or Home Unit Kit 
 
PPE (<20lb) 
- Nomex pants & shirt 
- 8” Leather fire boots & spare laces 
- Helmet & Headlamp 
- Goggles & Gloves 
- Fire shelter 
- Ear plugs 
- Water bottles 
 
PERSONAL GEAR (<45 lb, soft-sided bag) 
- Matches (can’t take on an airplane) 
- Signal Mirror & Compass 
- Jackknife (don’t pack in carry-on bag) 
- Parachute cord 
- Granola bar 
- First aid kit 

PERSONAL GEAR (continued) 
- Space blanket 
- AA batteries 
- Hat 
- Sunglasses / spare glasses 
- Prescriptions 
- Sunscreen 
- Bug spray 
- Bandana 
- Rain gear 
- Toiletries & flip flops for shower 
- Small towel 
- Flashlight 
- Extra clothing (cotton) 
- Warm jacket, hat, gloves 
- Alarm clock & batteries 
- Tent 
- Sleeping Bag & Pad 
- Handheld Radio (if you have one) 
- Lace-up, closed toe shoes/boots with 

traction soles and ankle support 
 
PIO TRAVEL KIT 
- Magnetic “Fire Information” signs 
- “Fire Information” Banner 
- PIO nametag 
- https://tinyurl.com/piotoolbox files on 

thumb drive (in case no internet avail) 
- Cell phone (if authorized) and charger 
- Portable power bank / solar charger 
- Headphones 
- Lavalier mic & extension cord (optional) 
- Selfie stick or tripod (optional) 
- Camera, batteries, memory cards, 

related cables (if authorized) 
- Laptop computer & cables (if authorized) 
- External webcam (optional) 
- Portable printer, cables, and ink (if 

authorized) 
- Folder for documentation & post-it tabs 
- Light duty staple gun and staples 
- Staple puller or pliers 
- Painter’s tape or scotch tape 
- Push pins 
- Pens and pencils, highlighters 
- Permanent markers (black and red) 
- Paper clips, rubber bands 
- 1-2 pages flip chart paper, folded 
- Power / surge strip 
- Green Laser Pointer 
 
PIO HOME UNIT KIT (additional items) 
- Unit Logs 
- Crew Time Report (CTR) Book 

https://tinyurl.com/piovirtual
https://www.nwcg.gov/publications/pms461
https://www.nwcg.gov/publications/pms461
https://tinyurl.com/piotoolbox
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PIO HOME UNIT KIT (continued) 
- General Message Forms 
- Request for Recognition Forms 
- Printer / Scanner/ Copier & Ink 
- Second monitor (optional) 
- Ring or LED video lights (optional) 
- Conference call speaker/mic 
- Router box / extra network cables 
- Surge strips / extension cords 
- Copy Paper / Colored Paper 
- File Box 
- Manila and/or Hanging Folders 
- 2-Pocket Folders 
- Accordion Folders 
- Clear Sleeves / Laminating Pages 
- Flip Charts / Markers / Easel 
- Dry Erase Board / Markers 
- 6”x9” Steno pads with rings on top 
- Binder Clips 
- Post-it Notes 
- 3-Ring Binders / 3-Hole Punch 
- Duct Tape / Blue Tape / Scotch Tape 
- Stapler / Staples / Staple Puller 
- Envelopes & Stamps 
- Large manila envelopes 
- Scissors 
- Cardstock or Photo Paper 
- Certificate Holders 
- Portable TV / Radio 
- Handheld people counter / clicker 
- AA & AAA batteries 
- Trash bags 
- Clear plastic / trash bags to cover boards 
- Calendar 
- Interagency Standards for Fire & Fire 

Aviation Operations (the “Redbook”) 
- National Interagency Standards for 

Resource Mobilization 
- Geographic Area Mobilization Guides 
- Local unit/state/US highway maps 
- Team templates 
- Hand tool 
- Water 
- Hand Sanitizer 
- Tissues / Paper Towels 
- PPE for Media 
- MREs 
- Cooler 

 
CHECK IN 

- Check in (resource order & red card) 
- If AD, provide paperwork to finance 
- Report to the lead PIO 
- Ground Support — vehicle inspection 
- Communications (clone radio, batteries) 

- Supply (hand tool, cooler, etc.) 
- Training Specialist — task book 
- Set up tent (before dark if possible) 

 
FIRST OPERATIONAL PERIOD 

- PIO Briefing 
- Call key contacts: PAO, JIC, Media, etc. 
- Set up daily PIO Cooperator call (set up 

FireNet Teams meeting for a call in #) 
- Order PIOs via General Message 

https://tinyurl.com/pioforms 
- Order supplies via General Message 

- Newspapers for media clippings 
- Yurt / Lights / Tables / Chairs 
- Phone / Answering Machine 
- Laptop / Network Connections 
- Printer / Copier 
- Flip Chart or Dry Erase Boards 
- Plywood Info Boards 

- Map Request via General Message 
- Specify quantity, type (including PDF), 

and date/time needed 
- Assign one person to pick up 

- Coordinate Key Contacts with Liaison 
- Set up workspace 
- Set up FireNet electronic file structure 

https://tinyurl.com/piofirenet 
- Set up email, Inciweb, social media, etc. 
- Request FireNet fire info phone # and set 

up voicemail (may need 2: public/media) 
- Set up news / media monitoring alerts 

https://tinyurl.com/piomonitor 
- Prepare and distribute the daily update 
- Establish info center location & hours 
- Determine trapline locations 
- Assess task book needs 
- Establish Doc Box / e-Doc Box (p.35) 
- Incident Info Links for IAP Cover to PSC 

 
ORDERING PIOs 

- Submit General Message to ORDM. 
- Specify quantity, qualification (& if trainees 

acceptable), report location, date/time 
needed, and contact for questions. 

- At PL4-5 request ≥48 hours out (will accept 
sooner) to help order get filled. 

- Specify if rental car, laptop, cell phone, 
camera, and/or printer are authorized. 

- If a name request, confirm availability 
before ordering, specify name in IROC, 
qualification, phone number(s), home unit 
id, and home unit dispatch & phone. 
https://tinyurl.com/piovirtual 

- Ordering Process / Name Requests: 
nifc.gov/nicc/mobguide/Chapter_20.pdf 

https://www.nifc.gov/standards/guides/red-book
https://www.nifc.gov/standards/guides/red-book
https://www.nifc.gov/sites/default/files/NICC/3-Logistics/Reference%20Documents/Mob%20Guide/2024%20NATIONAL%20INTERAGENCY%20STANDARDS%20for%20RESOURCE%20MOBILIZATION.pdf
https://www.nifc.gov/sites/default/files/NICC/3-Logistics/Reference%20Documents/Mob%20Guide/2024%20NATIONAL%20INTERAGENCY%20STANDARDS%20for%20RESOURCE%20MOBILIZATION.pdf
https://www.nifc.gov/nicc/geographic-areas
https://www.firenet.gov/node/48
https://tinyurl.com/pioforms
https://tinyurl.com/piofirenet
https://firenet365.sharepoint.com/:f:/s/Comm_Plans/EuJGwGrNUT9HpGYJ9RS0_bMBm5rAaTI3W3KpF4Wjy-0Brw?e=R9IhmX
https://tinyurl.com/piomonitor
https://tinyurl.com/piovirtual
https://www.nifc.gov/nicc/mobguide/Chapter_20.pdf
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IN-BRIEFING NOTES 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
Review: 
 Incident Action Plan (IAP) — including the ICS 202 Incident Objectives 
 ICS-209, Incident Status Summary 
 Delegation of Authority — especially expectations for incident information 
 Transition plan from outgoing IMT — including list of current / ordered resources 
 Local unit information plan from host unit Public Affairs Officer (PAO) 
 Existing fire info resources — Inciweb, social media, Home Unit website, etc. 
 Wildland Fire Decision Support System (WFDSS) — including Management Action Points 
 Fire Management Plan / Fire History / Local Fire Ecology Info 

 
 



6 

 

IN-BRIEF Date/Time 
Incident Name Complexity  
IMT Name IC Name 
Ownership Jurisdiction 
Location 
 

County 

Legal Coordinates 
Cause Elevation 
Reported by Reported When 
Date of Origin Time of Origin 
Estimated Size Estimated % Containment 
Est Containment Date/Time Est Control Date/Time 
Injuries  Cost 
Resources Responding (show how many) and Total # Personnel 
  Type 1 Engines   Type 1 Hand Crews    Type 1 Helicopters 
  Type 2 Engines   Type 2 Hand Crews   Type 2 Helicopters 
  Type 3 Engines   Modules   Type 3 Helicopters 
  Type 4 Engines   Overhead   Air Tankers 
  Type 5 Engines   Dozers   SEATs 
  Type 6 Engines   Water Tenders   Retardant Drops 
  Type 7 Engines   Other   Water Drops 
Values at Risk 
 
 
Structures Threatened: Damaged: Destroyed: 
Evacuations 
 
 
Restrictions 
 
 
Closures 
 
 
Cooperators 
 
 
 
Fire Behavior 
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Fuel Type 

Topography 
 
 
Weather 
 
 
 
 
Growth Potential 
 
Current Status 
 
 
 
 
Current Actions 
 
 
 
 
Planned Actions 
 
 
 
 
 
Smoke 
 
 
Socio/Political Concerns 
 
 
 
Other Current Incidents in the Area 
 
 
Significant Past Incidents 
 
 



8 

 

QUESTIONS FOR HOST UNIT PUBLIC AFFAIRS OFFICER (PAO) 
Always check in Regularly with the Local PAOs for All Agencies on the Delegation of Authority 

 
MANAGEMENT, LEADERSHIP, and 
DECISION-MAKING Unified Command? 
 
 
INCIDENT INFO CENTER Location, who 
will manage, staffing, hours, phone #s? 
 
 
INCIDENT INFO FIELD OPERATIONS 
Location, agencies, who will coordinate? 
 
 
LOGISTIC SUPPORT What is computer, 
phone, cell, email capacity of incident? 
Laminator, LCD projector, printer, fax, etc.? 
Phones at ranger station, EOC, etc.? 
 
 
DAILY FACT SHEETS Who is responsible, 
how often, who will prepare, what template 
will be used, which logos to use? 
 
 
PRESS RELEASES ON FIRE ACTIVITY 
What template will be used, who approves, 
etc.? Translations? 
 
 
CONTACTS Email and phone lists 
(Agency, Media, Elected Officials, 
Community, etc.) Who will send out? 
 
 
SENSITIVE TOPICS What are they? Who 
will handle? 
 

COMMUNITY CONTACTS Evacuation 
centers, trap lines, etc.? When, where, and 
how often? Which ranger stations should 
be on the trapline? Local translators 
available? 
 
 
WEBSITE Inciweb or other? Social media? 
Storymap? Who will update, how often? 
Local unit webmaster? Passwords? 
 
 
COMMUNITY MEETING Location, format, 
how often? Who will manage / conduct? 
Role of the agency official? Translators? 
 
 
MEDIA/PRESS CONFERENCES Media 
coordination, how often, who will conduct, 
who will send information to media? 
 
 
ELECTED OFFICIALS meetings and on-
site tours of the incident. Who will contact 
and coordinate? 
 
 
INCIDENT DOCUMENTATION Specific 
needs? Who will monitor media coverage? 
Photo / video name / caption / credits? 
 
 
INCIDENT COMMUNICATION 
STRATEGIES Protocol for release of 
critical info? Leads & Deputies? 
 
 

 
DISCUSS ROLES WITH EMERGENCY OPERATIONS CENTER (EOC) or 

JOINT INFORMATION CENTER (JIC) PIO 
https://tinyurl.com/nimospiobasic 

 

Local PIO Resources 
Name Phone Qual Availability 

    
    
    
    
    

https://tinyurl.com/nimospiobasic
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PAO / PIO ROLES AND RESPONSIBILITIES 
 

Host Unit PAO 
 Prepares / updates home unit emergency communications plan prior to incident. 
 Through the agency administrator (AA), and in discussion with the incident lead PIO, assigns 

info objectives, and duties to the incoming PIO. Assigned PIO duties may include part or all of 
the emergency info responsibilities such as: community info, info center management, media 
contacts, web updates, daily info sheet updates, interagency info sharing, media briefings, the 
use of team and agency logos. 

 The agency Public Affairs Officer (PAO) usually retains some or all duties that directly support 
the AA such as: congressional and other elected official contacts, agency lead on fatalities or 
serious accidents during the initial stages, spokesperson on issues related to agency policy, 
announcement of the cause of fires, media conferences. 

 
Team PIO 
 Designs / executes an incident info 

strategy to achieve the AA’s assigned 
objectives. 

 Orders, assigns duties, and evaluates 
assistant PIOs working for IMT. 

 Manages incident-within-an-incident in 
close coordination with PAO. 

 Follows AA’s protocol for fatalities and 
serious accidents. 

 Conducts community meetings 
requested by AA. 

 Develops / implements strategy to keep 
incident personnel informed. 

 Advises IC on emerging issues and 
communication strategies. 

 Coordinates with other incident PIOs in 
the area including JIC. 

 Demobilizes PIO personnel and 
resources. 

 Prepares transition plan and incident 
PIO narrative. 

 

DUTY 
• Be proficient in your job, both technically 

and as a leader. 
• Make sound and timely decisions. 
• Ensure tasks are understood, 

supervised, and accomplished.  
• Develop your subordinates for the future. 
 
RESPECT 
• Know your subordinates and look out for 

their well-being. 
• Keep subordinates informed. 
• Build the team. 
• Employ your subordinates in accordance 

with their capabilities.  
 
INTEGRITY 
• Know yourself and seek improvement. 
• Seek and accept responsibility for your 

actions. 
• Set the example. 

 
Area Command 
 Develop / execute info strategy designed to meet AA’s objectives as outlined in the Delegation 

of Authority. 
 Coordinates with unit PAO to reduce duplication of efforts and strengthen relationships. 
 Inventories personnel assigned within the command. 
 Assists in filling PIO resource orders, as needed by PIOs within the command. 
 Manages an info center that meets AA objectives. 
 After discussions with Lead PIOs and ICs, reassigns info resources as needed within Area 

Command. 
 Orders, assigns work, and evaluations PIO personnel working for AC. 
 Supports incident PIOs in obtaining info/resources they need to accomplish their mission (i.e., 

road closures and evacuation info). 
 Supports AC info needs. 
 Provides media with summary briefings on incidents within the command. 
 Facilitates info sharing and issue identification among incident PIOs within the command. 
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JOINT INFORMATION CENTER (JIC) ROLES AND RESPONSIBILTIES 
https://tinyurl.com/piojic 

Lead PIO: 
• Responsible for managing the JIC; 
• Serves as advisor to IC/UC; 
• Provides overall communication policy direction; 
• Recommends and develops strategy for messages, briefings, and news releases; 
• Obtains approval from those in authority before releases are made; and 
• Conducts JIS/JIC briefings (live or virtual) to update staff regarding Incident Command activities. 
 
Information Gathering: 
• Response Partners — Coordination with supporting response agencies and their PIOs at EOCs, 
incident command posts, and other locations to gather information on the incident. 
• Media Monitoring Analysis/Rapid Response — Entails reviewing media reports for accuracy, content, 
and possible response. 
• Research and Writing: 

- Products — Writing materials such as media releases, fact sheets, flyers, etc. 
- Graphics Support — Entails designing layouts, developing PowerPoint presentations, and creating 

graphics for a range of materials (e.g., newsletters, flyers, etc.). 
• Audio-Visual: 

- Broadcast Operations — Entails developing video documentation, special productions, remote live 
interview feeds, and logistical support of public meetings and presentations. 

- Photo Video — Entails providing still photography documentation to support print and internet 
media needs, and video documentation to support broadcast media needs. Also includes 
collecting materials for agency archives. 

 
Information Dissemination: 
• Briefing/Special Events — Entails handling events such as news conferences, media briefings, VIP 
visits, and tours for senior officials of affected areas. 
• Media Relations: 

- News Desk — Serves as the primary point of contact for the media. 
- Spokesperson — Prepares and conducts regular news briefings and conferences. 

• Web Support — Entails creating and maintaining web pages and blogs containing information about 
the incident for use by the public and the media. 
• Public Inquiries — Entails responding to questions from citizens, making referrals, and developing a 
log of telephone calls, e-mails, etc., containing names, addresses, the type of calls, and any necessary 
follow-up actions. 
 
Operations Support: 
• Special Needs/Multilingual — Entails providing language translation and other services to ensure 
appropriate and timely information reaches those in the affected areas with special needs. 
• Facility Support — Coordinates with the JIC Facility Liaison to maintain and support the JIC operations 
concerning the facility and resources. 
 
Liaison: 
Provides a coordinated two-way communication link with key program areas and other entities involved 
in the response and recovery operation (e.g., elected officials, community leaders, VIPs, and other 
governmental or NGO support agencies). 
 
DEMOBILIZING THE JOINT INFORMATION CENTER (JIC) 
• Prepare a comprehensive deactivation news release for lead-agency approval and distribution; 
• Notify community, media, agency communications managers and local officials about closing and 
provide regional contact information; 
• Provide casebooks to communication managers whose organizations will assume responsibility for 
ongoing information; 
• Complete an after-action report and participate in evaluation discussions; 
• Return borrowed equipment and supplies; 
• Inventory equipment and supplies; and 
• Replenish “Go Kits” as necessary.

https://tinyurl.com/piojic
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2025 NATIONAL FIRE YEAR THEMES 
https://www.nifc.gov/fire-information/national-fire-year-themes 

 

Firefighter and public safety are always the highest priority. 
• Wildland firefighters work to protect lives, property, and natural and cultural resources 

when responding to wildfires. 
• With each new fire start, fire managers assess risk to identify safe and appropriate 

management actions. Firefighters may not engage in a wildfire until risk is mitigated to 
an acceptable level. 

 
Local wildfire response is based on the national coordination system. 

• The national coordination system is designed to allow wildland fire resources to rapidly 
scale up or down as needed. This allows geographic areas with a lower risk of wildfire 
to dispatch resources and personnel to geographic areas with a higher risk. 

• Over 95% of wildfires are controlled during the first 24 hours of initial response. 
 
Wildland fire programs continue to adopt new technologies to improve suppression 
efforts. 

• The use of uncrewed aerial systems (UAS/drones), remote smoke and camera 
detection systems, improvements in communication capabilities, are a few of the new 
technologies that fire programs are using. Updated data and modeling programs are 
improving fire suppression and fuels management. 

 
The wildland urban interface is becoming increasingly complex for fire suppression. 

• The last 10 years of wildfire activity has been some of the most destructive and costly 
in U.S. history. The complexity of fire suppression has increased due to urban sprawl, 
an overabundance of fuel (vegetation), longer and hotter summer temperatures, and 
extreme weather conditions. The public can find more information in regard to being 
prepared for wildfire season at NFPA — Firewise USA®, 
https://www.nfpa.org/education-and-research/wildfire/firewise-usa. 

 
Be smoke ready. 

• During wildland fires, air quality can change quickly. Know your risk to wildfire smoke 
and plan ahead to reduce exposure. For recommended actions, as well as smoke 
forecasts and current information, visit: www.airnow.gov/wildfires/. 

. 
Recreate responsibly: The public plays a valuable role in wildfire prevention. 

• On average, 85% of all wildfires are caused by humans each year. Many of these 
wildfires occur near roads, communities, recreation areas, and threaten public safety. 

 
Wildland fire programs apply fuels treatments to reduce wildfire risk to communities and 
natural and cultural resources. 

• Wildland fire agencies apply a variety of fuels treatments (mechanical thinning, 
prescribed fire, restoration) to reduce the amount of available fuel (vegetation) that 
fuels unwanted wildfires. By proactively removing fuel, fire agencies are better 
protecting local communities from risk of wildfire. 

  

https://www.nifc.gov/fire-information/national-fire-year-themes
https://www.nfpa.org/education-and-research/wildfire/firewise-usa
http://www.airnow.gov/wildfires/
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COMMUNICATING FIRE Telling the Story Clearly, Consistently, and Professionally 
https://www.nifc.gov/sites/default/files/document-media/CommunicatingFire-NIFC.pdf 
 
A Simple Overview of Guidance for 
Implementation of Federal Wildland Fire 
Management Policy — 2009 
 
• Response to wildland fire will be 

coordinated across levels of government 
regardless of the jurisdiction at the 
ignition source. 

• Wildland fire is a general term. It 
describes a non-structure fire that occurs 
in the wildland. There are two distinct 
categories: 
- Wildfires — unplanned ignitions or 

prescribed fires that are declared 
wildfires. 

- Prescribed fires — planned ignitions. 
• A wildland fire may be concurrently 

managed for one or more objectives, 
which can change as the fire spreads. 
- Objectives are affected by changes in 

fuels, weather, and topography; public 
understanding and tolerance; and 
involvement of governmental 
jurisdictions that may have different 
missions and objectives. 

• Management response to a wildland fire 
on federal land is based on objectives 
established in the applicable land, 
resource, and/or fire plan. 

• Managers will use a decision support 
process to guide and document wildfire 
management decisions. 
- The process will provide situational 

assessment, analyze hazards and 
risk, define implementation actions, 
and document decisions and rationale 
for those decisions. 

Source: Guidance for Implementation of 
Wildland Fire Policy 

Proper Personal Protective Equipment 
(PPE) — A Simple Checklist 
 
Make sure photos of firefighters on the line 
that you disseminate to the media and the 
public include these basics: 
• Hardhat 
• Fire shelter 
• Nomex™ shirt and pants 
• Sleeves on shirt rolled all the way down 
• Gloves (unless in the act of writing or 

using the radio) 
• Eye protection – goggles / safety glasses 
• 8-inch fire boots 
If the photo does not include the above 
items, do not use it. 
Source: Interagency Standards for Fire and 
Fire Aviation Operations 
 
Simplify, Simplify, Simplify...Fire Press 
Releases Do Not Need to Be 
Complicated 
 
Press releases should include: 
• How the fire started 
• What is planned to be done: what the 

park is doing about the fire 
• Current conditions: size, location, as well 

as concerns 
• Why: prevent loss/damage of … or 

achieve benefits for… 
• Where: location work is being done 
• When: timing of work activities — now or 

in the future 
• How: what resources will be used 
• Who: agencies/people involved 
• Safety messaging: always include critical 

safety messages 
Source: NIFC External Affairs 

 
Produced by National Interagency Fire Center External Affairs (NIFC EA) 
For more information, visit https://www.nifc.gov/fire-information/pio-bulletin-board/contacts 
 
National Talking Points — themes, agency messages, smoke, UAS, military support 

https://www.nifc.gov/fire-information/pio-bulletin-board/hot-topics 

https://www.nifc.gov/sites/default/files/document-media/CommunicatingFire-NIFC.pdf
https://www.nifc.gov/fire-information/pio-bulletin-board/contacts
https://www.nifc.gov/fire-information/pio-bulletin-board/hot-topics
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KEY MESSAGES 
Consider Your Audience. Tell the Story What, Why, How, Who, When, Where 

 
Key Message: 
 
 
Key Message: 
 
 
Key Message: 
 
 
PIOs on incidents can respond to questions from all news media, including national news media, about 
the incident only. PIOs should refer all questions that are broader in scope to the host unit Public Affairs 
Officer to determine whether they should be addressed locally, regionally, or nationally. 
 

MEDIA INTERVIEWS 
https://tinyurl.com/piomedia 

ANSWERS TO DIFFICULT 
QUESTIONS 

FIRELINE VISITS 

Before the Interview 
- Ask the reporter what questions 
  should I expect? Live or 
  Taped? Where to look? 
 
 
During the Interview 
- Deliver factual messages on 

behalf of the incident. 
- Give 10-20 second answers. 
- Use key messages. 
- Avoid jargon or acronyms. 
- Say important thing first. 
- When you’re done, be quiet 

between questions. 
- If you misspeak, ask to start 

again (if taped). 
- Remove sunglasses / hats. 
- Look at the reporter, not the 

camera. 
- Stick to your knowledge and 

avoid speaking for other incident 
personnel. 

- Never speak off the record, 
exaggerate, try to be cute or 
funny. 

- Don’t speculate, give opinions, 
or say, “no comment.” 

- Don’t speak for other agencies. 
- Avoid yes/no answers. 
- Don’t disagree with the reporter, 

instead clarify and correct the 
information. 

- Conclude with a key message. 
- Take advantage of the question 

“Is there anything else you want 
to add” to emphasize a key 
message. 

 
QUESTIONS TO EXPECT 

What happened? 
What are you doing about it? 
What does it mean to me? 

 
BRIDGE TO KEY MESSAGE 

- I want to emphasize… 
- It’s important to remember… 
 

Asked about a problem? 
Talk about a solution. 

 
- We are working to protect our 

values at risk where we can do so 
safely and effectively. 

- This is an evolving situation, and I 
will update you as soon as we 
have additional information. 

- Everyone is working hard to reach 
objectives safely and efficiently. 

- All of our efforts are directed at 
bringing the situation under 
control. 

- I’m not the authority on that 
subject. You should talk to… 

- I am unfamiliar with that statement 
and am not prepared to respond to 
it. 

- I will look into it and get back to 
you. 

- That’s a hypothetical question and 
it’s not appropriate for me to 
speculate. 

- Our job is to manage public lands 
according to the law, balancing 
public use and resource 
protection. 

 
Escorted visits to the fireline 
must have the approval of the 
IC/Burn Boss. 
 
Visitors must maintain 
communication with DIVS or 
fireline supervisor of visit area. 
 
Visitors must have training in 
the proper use of PPE & 
shelter. 
 
Escorts must be a qualified 
single resource boss or 
approved by IC/Burn Boss. 
 
Must wear required PPE: 
- Wildland fire boots 
- Fire shelter (M-2002) 
- Helmet with chinstrap 
- Goggles/safety glasses 
- Ear plugs 
- NFPA 1977 compliant 

flame-resistant long sleeve 
shirt and trousers 

- Leather or leather/flame-
resistant gloves 

- Cotton undergarments 
 
Hand tool and water required. 
 
Unescorted visitors to the 
fireline must have: 

- Light duty fitness level 
- Comms/radio training 
- S-130, S-190, & RT-130 
- Or IC/Burn Boss approval 

 
https://www.nifc.gov/standards/

guides/red-book 
 Chapter 7, Safety for 

Personnel Visiting Fires 

https://tinyurl.com/piomedia
https://www.nifc.gov/standards/guides/red-book
https://www.nifc.gov/standards/guides/red-book
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COMMUNICATION STRATEGY 
https://tinyurl.com/piocommunicationstrategy 

 
SITUATION / SOCIO-POLITICAL CONCERNS — Fire history? Economics? Tourism? etc. 
 
AUDIENCE — Consider incident specific stakeholders / audiences.

- Local communities / businesses 
- Visitors / recreationists 
- Media 
- Elected officials 

 

- Agency Personnel 
- Incident Personnel 
- Partner Agencies 
- Nearby Incidents 

 
OBJECTIVES — Incorporate info related objective(s) from delegation of authority or IAP. 
- Keep internal and external audiences informed with accurate, timely information. 
- Be the first and best source of information about the fire; Update information frequently. 
- Address rumors to prevent confusion. 
- Accommodate media requests quickly and safely. 
- Communicate consistent messages about the benefits and risks associated with wildland fire. 
- Collaborate with interagency and community partners for maximum efficiency and effect. 
 
STAFFING — Consider opportunities to incorporate locals, and when to scale up or down. 
Current     Target 
 
KEY MESSAGES https://tinyurl.com/piotalkingpoints — Incorporate incident specific messages. 
- Firefighter and public safety is always the highest priority during wildfires. 
- Wildfires are a no drone zone. If you fly, we can’t. Every time a drone is spotted near the fire all 

aircraft are grounded until we can be sure the drone is clear of the area. knowbeforeyoufly.org 
- Wildfire behavior is largely contingent upon weather and fuel conditions. 
- Partnerships at local, regional, and national levels help us be more effective. 
- Visit airnow.gov/wildfires/ for info on air quality and how to protect yourself from wildfire smoke. 
- Homeowners can help firefighters by creating defensible space around your home.Firewise.org 
- Visit ready.gov/wildfires to learn what to do before, during, and after a wildfire. 

 
TACTICS — Discuss with host unit PAO(s); plan for the long term / team transitions. Consider 
which tactics are the most effective way to reach your target audiences.
 Info Center 
 Daily Briefings 
 Daily Updates and/or News Releases 
 Notification Calls to Key Contacts 
 Email — https://www.firenet.gov (p.34) 
 Host Unit Website 
 Inciweb NIFC.gov > PIOBB > Inciweb 
 Interagency Fire Info Website 
 Social media NIFC.gov > PIOBB > SM 
 Business Cards with Fire Info # / links 
 Fire Info Boards 
 Traplines 
 Roving Contacts 
 Community Meetings 

 Community Events 
 Educational Handouts—Firewise, etc. 
 Media Escorts 
 Press Conference 
 Public Service Announcements 
 Tours of Camp / Fire 
 VIP Briefing Packets 
 Camp Boards 
 Info for Spike Camp 
 Employee Meetings 
   Internal Texts 
 Feature Stories / Content 
 Storymap 
 Other 

 
EVALUATION https://tinyurl.com/piomonitor 
Accurate media coverage? Web / social media chatter? Community feedback? Host unit 
feedback? Site Analytics: Twitter, Facebook, etc.? Consider when to adapt your strategy. 

 

https://tinyurl.com/piocommunicationstrategy
https://tinyurl.com/piotalkingpoints
https://knowbeforeyoufly.org/
https://www.airnow.gov/wildfires/
http://firewise.org/
https://www.ready.gov/wildfires
https://www.firenet.gov/
https://www.nifc.gov/fire-information/pio-bulletin-board/inciweb
https://www.nifc.gov/fire-information/pio-bulletin-board/social-media
https://tinyurl.com/piomonitor
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PIO ORG CHART 
If the span of control exceeds three to seven, make changes. The optimum ratio is five-to-one. 

 
  LEAD PIO 

 
 

  

   
 
 

  

   
 
 

  

OFFICE DIGITAL  MEDIA COMMUNITY 
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PIO DAILY ASSIGNMENTS 
Accessibility How-Tos: https://www.section508.gov/create/ & https://tinyurl.com/pio-accessibility 

 

INFO SHOP — ALL WHO PROJECTS WHO 

Clone Radio 
https://tinyurl.com/radiohowto 

 Communication Strategy (p.14) 
https://tinyurl.com/piocommstrategy 

 

AM Briefing 
Pick up Copy of Daily IAP 

 Talking Points & Info Products 
https://tinyurl.com/piotalkingpoint

 

AM Ops Briefing for PIOs  Storymap (with Host PAO approval) 
https://tinyurl.com/piomapresources 

 

AM PIO Meeting  Demobilization Plan  
Pick Up Lunches / Water  Transition Plan 

https://tinyurl.com/piotransition 
 

Shower/Break  Executive Summary 
https:/tinyurl.com/pioforms 

 

Unit Log — include Stats 
# Contacts, Attendees, etc. 

 Thank You Letters 
https://tinyurl.com/piothankyou 

 

CTRs https://tinyurl.com/pioforms 
https://tinyurl.com/ctr-howto 

 Documentation (p.35) 
https://tinyurl.com/pioedocbox 

 

PM PIO Meeting  Task Book Needs (p.19)  
Charge Devices   Task Book Evaluations 

https://tinyurl.com/taskbook-eval 
 

Save Files to e-Doc Box (p.35) 
https://tinyurl.com/pioedocbox 

 PIO Evaluations 
https://tinyurl.com/pioforms 

 

   
 

 

IMT  COMMUNITY  
AM Briefing  Request Boards 

https://tinyurl.com/piotrapline 
 

Stand up C&G Meeting  Pick Up Maps  
Update PAO(s)  Daily Copies (p.18)  
Cooperator PIO Call  Evacuation Center  
Cooperator Meeting  Trapline A (p.18) 

https://tinyurl.com/piotrapline 
 

C&G Meeting  Trapline B  
PM Briefing  Camp Boards  
Planning Meeting  Mail  
Incident-Within-Incident Practice  Camp Tour  
Internal Messages 
https://tinyurl.com/internalmessages 

 Community Meeting (p.39) 
https://tinyurl.com/piocommunitymeeting 

 

Daily PIO Training / Tips    -Scout Location  
tinyurl.com/piodailyassignments    -Agenda / Confirm Speakers  
MEDIA / VIP    -Copies / Supplies  
Press Conference (p.38)    -Facility details/contact to 

  ORDM for land use agreement 
 

Media Phone 
https://tinyurl.com/piophone 

   -Tech Support 
  https://tinyurl.com/pioaccessibility 

 

Media Escort. (p.13)    -Greeters  
Media Interviews 
https://tinyurl.com/piomedia 

 Daily Map Request 
https://tinyurl.com/piomapresources 

 

VIP Packet  Final / Long Term Message 
https://tinyurl.com/postfireresources 

 

VIP Escort (p.38)  Dismantle Trapline  
   

 
 

https://www.section508.gov/create/
https://tinyurl.com/pio-accessibility
https://tinyurl.com/radiohowto
https://tinyurl.com/piocommstrategy
https://tinyurl.com/piotalkingpoints
https://tinyurl.com/piomapresources
https://tinyurl.com/piotransition
https://tinyurl.com/pioforms
https://tinyurl.com/piothankyou
https://tinyurl.com/pioforms
https://tinyurl.com/ctr-howto
https://tinyurl.com/pioedocbox
https://tinyurl.com/taskbook-eval
https://tinyurl.com/pioedocbox
https://tinyurl.com/pioforms
https://tinyurl.com/piotrapline
https://tinyurl.com/piotrapline
https://tinyurl.com/internalmessages
https://tinyurl.com/piocommunitymeeting
https://tinyurl.com/piodailyassignments
https://tinyurl.com/piophone
https://tinyurl.com/pioaccessibility
https://tinyurl.com/piomedia
https://tinyurl.com/piomapresources
https://tinyurl.com/postfireresources
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OFFICE WHO  PHONE  WHO  
Pick Up Maps  Staff Phones 

https://tinyurl.com/piophone 
 

Print/Make Copies  Contact Log  
Write AM Update 
https://tinyurl.com/pioupdate 

 AM Phone ON  

Translate Update 
tinyurl.com/pio-translate 

 AM Voicemail  

Staff Info Center  Return Calls  
Media Clippings  PM Voicemail   
Doc Box 
https://tinyurl.com/pioedocbox 

 PM Phone Off  

Write PM Update    
IAP Message 
https://tinyurl.com/pioiaptp 

   

PIO Phone List    
Key Contact List    
PIO Glidepath    
    

DIGITAL AM Inciweb SocMe DIGITAL PM Inciweb SocMe 

Post IR Map & IC Approved 
Acreage  

     

Post PIO Map (p.34)      
Post AM Update   Post PM Update   
Ops Video Update 
https://tinyurl.com/opsvid 

  Post 209 Inciweb 
https://tinyurl.com/pioSIT209 

  

Post Smoke Outlook 
https://wildlandfiresmoke.net 

  Community Mtg Comments   

Post Community Meeting 
Announcement 

  Post Community Meeting 
Recording 

  

      
DIGITAL SETUP   DIGITAL ONGOING   

Incident Email (p.35) 
 

 Analytics (p.38) 
https://tinyurl.com/pioforms 

 

Email Signature 
https://tinyurl.com/pioesign 

 Respond Email  

e-File Setup 
https://tinyurl.com/pioedocbox 

 Email List (p.35) 
https://tinyurl.com/piofirenet 

 

Inciweb Access (p.36) 
tinyurl.com/pioinciweb 

 Monitor Comments   

Add Inciweb Cooperator & 
Related Links 

 Monitor / Share Partner 
Updates 

 

Backup Website   e-News Clippings 
https://tinyurl.com/piomonitor 

 

Social Media Access 
https://tinyurl.com/socmepio 

 Photos/Videos (p.34) 
https://tinyurl.com/piovideo 

 

QR Codes 
https://tinyurl.com/pioqrcode 

 Post Closures  

Forward News Alerts 
to Incident Email 

 Analytics 
https://tinyurl.com/pioanalytics 

 

Graphics & Logos 
tinyurl.com/piographics 

 Auto-Response 
https://tinyurl.com/pioautoreply 

 

PIO Quick Reference 
https://tinyurl.com/pioquickreference 

 Transition or Final 
Message 

 

    

https://tinyurl.com/piophone
https://tinyurl.com/pioupdate
https://tinyurl.com/pio-translate
https://tinyurl.com/pioedocbox
https://tinyurl.com/pioiaptp
https://tinyurl.com/opsvid
https://tinyurl.com/pioSIT209
https://wildlandfiresmoke.net/
https://tinyurl.com/pioforms
https://tinyurl.com/pioesign
https://tinyurl.com/pioedocbox
https://tinyurl.com/piofirenet
https://tinyurl.com/pioinciweb
https://tinyurl.com/piomonitor
https://tinyurl.com/socmepio
https://tinyurl.com/piovideo
https://tinyurl.com/pioqrcode
http://www.google.com/alerts
https://tinyurl.com/pioanalytics
https://tinyurl.com/piographics
https://tinyurl.com/pioautoreply
https://tinyurl.com/pioquickreference
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DAILY COPIES 

PLOTTER PAPER SIZES 
ANSI C 17 x 22  ANSI E 34 x 44 ARCH B 12 x 18  ARCH D 24 x 36 
ANSI D 22 x 34  ARCH A 9 x 12 ARCH C 18 x 24  ARCH E 36 x 48 

 
 IAP 209 Sit 

Rpt 
Update Map Smoke Mtg 

Flyer 
UAS Other 

PIOs          
Info Center          
Camp 
Boards 

         

Traplines Internal  Internal        
Cooperator 
Meeting 

         

Community 
Meeting 

Internal Internal        

TOTAL          
  

 

TRAPLINE 
Local Businesses, Ranger Stations, Roadblock Staff, ICP Security, ICP Boards, Helibase, etc. 

Location  Notes (pins, tape, etc.) What’s Posted 
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

 Equipment Assigned To Out In Return To 
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TASKBOOKS & EVALS 
https://nwcg.gov/publications/position-taskbooks & https://tinyurl.com/pioforms 

Trainee / Qualification Taskbook Needs Trainer Taskbook Evaluation 
  

 
   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

  
 

   

 
 

    

 

https://nwcg.gov/publications/position-taskbooks
https://tinyurl.com/pioforms
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FIRENET TIPS 
 
TIPS FOR PIOS https://tinyurl.com/piofirenet 
Quick Reference Template 
https://tinyurl.com/pioquickreference 
User Guides https://www.firenet.gov/node/57 
Training https://www.firenet.gov/node/18 
 
REQUESTING A FIRENET ACCOUNT 
https://www.firenet.gov/node/34 > #8 select 
IMT; #9 current assignment or IMT 
-PIOs who need access to the shared 
incident inbox or incident phone # will need a 
named account. 
-Others can access as a guest. 
- Non-federal users should complete the 
annual security test, fill out the access 
request form, then provide a copy of their 
certificate to a federal employee to submit as 
their sponsor (dispatch, lead PIO, team 
member, etc.) 
https://www.firenet.gov/node/27 
-Setup Authenticator App so you can login 
with Wi-Fi if no cell coverage 
https://www.firenet.gov/node/21 
 
LOGGING INTO FIRENET 
-Login at https://www.office.com/ with your 
username (firstname_lastname@firenet.gov) 
-Click on the 9 square waffle on the top left to 
access Outlook, Teams, etc. 
 
FIRENET CHROME BROWSER 
https://www.firenet.gov/node/37 
-Open Chrome from your Start Menu 
-On top right, select the person icon 
-Select dropdown then select “Add” 
-Select “Continue without an account” 
-Set up customizations to make it easy to 
recognize FireNet profile 
-Choose a theme color (optional) 
-Create a desktop shortcut > Done 
-Manage Screens and Notifications 
https://tinyurl.com/piofirenet 
 
INCIDENT SETUP REQUEST 
https://www.firenet.gov/node/55 
-Lead PIO should coordinate Incident FireNet 
Team request with PSC & ITSS (Note: Type 3 
organization may have created one) 
 
MEETINGS https://tinyurl.com/firenetmeetings 

 
INCIDENT INBOX 
-Lead PIO or designee can delegate shared 
inbox with FireNet Incident Account Tracker 
https://www.firenet.gov/node/44 
-Incident Team > General Channel > Account 
Tracker > Choose the right Tab at the bottom 
for your team > Enter info for PIOs needing 
inbox access > email 
incident.helpdesk@firenet.gov from the 
shared inbox to advise the tracker has been 
updated; include link to the tracker in Teams 
-Strikethrough names as PIOs demob 
-To open shared inbox, from 
https://outlook.office365.com/mail/ 
> Click on your profile picture on top right > 
Open another mailbox > enter incident email 
> Enter (will open a new tab) 
Signature https://tinyurl.com/pioesign 
Auto-Reply https://tinyurl.com/pioautoreply 
Forward https://tinyurl.com/eautoforward 
Contact Lists https://tinyurl.com/pioemaillists 
 
MS TEAMS INCIDENT PHONE NUMBER 
https://www.firenet.gov/node/53 
-<1-3 lines available / IMT for use as public 
and/or media phone line on active incidents 
-When incident setup request, lead PIO can 
reply to welcome email to request area code 
-If previous IMT set up FireNet but you need 
to add an incident # later contact 
incident.helpdesk@firenet.gov to request 
-Teams > Calls > Cog Wheel Settings > Calls 
- Can forward to one cell # or to a group of 
PIOs Teams accounts — can choose order 
- Voicemail will go to personal named FireNet 
account for person who made request 
-Create rule to forward voicemail to incident 
inbox https://tinyurl.com/piophone 
 
FAQs https://www.firenet.gov/node/20 
- You’re automatically logged out every 18 hrs 
- Access https://www.office.com/ via a 
  browser on a mobile device 
Finding Deleted Files 
https://tinyurl.com/findingdeletedfiles 
Pswd Reset https://tinyurl.com/firenetreset 
Sharing Files Publicly (ex. with media) 
https://tinyurl.com/firenetpublicfilesharing 
Planner https://tinyurl.com/piofirenet 
Forms https://tinyurl.com/firenetformqrcode 

 

https://tinyurl.com/piofirenet
https://tinyurl.com/pioquickreference
https://www.firenet.gov/node/57
https://www.firenet.gov/node/18
https://www.firenet.gov/node/34
https://www.firenet.gov/node/27
https://www.firenet.gov/node/21
https://www.office.com/
https://www.firenet.gov/node/37
https://tinyurl.com/piofirenet
https://www.firenet.gov/node/55
https://tinyurl.com/firenetmeetings
https://www.firenet.gov/node/44
mailto:incident.helpdesk@firenet.gov
https://outlook.office365.com/mail/
https://tinyurl.com/pioesign
https://tinyurl.com/pioautoreply
https://tinyurl.com/eautoforward
https://tinyurl.com/pioemaillists
https://www.firenet.gov/node/53
mailto:incident.helpdesk@firenet.gov
https://tinyurl.com/piophone
https://www.firenet.gov/node/20
https://www.office.com/
https://tinyurl.com/findingdeletedfiles
https://tinyurl.com/firenetreset
https://tinyurl.com/firenetpublicfilesharing
https://tinyurl.com/piofirenet
https://tinyurl.com/firenetformqrcode
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NWCG STANDARDS FOR ELECTRONIC DOCUMENTATION 
https://tinyurl.com/pms277 & https://tinyurl.com/pioedocbox 

 
 

 

The Information Channel folders contain working files. Only final records belong in the e-Doc Box. 
 

When multiple IMTs work on a fire, create a channel subfolder with IMT name for working files. 
 

When a working document is complete and becomes a record, it will be moved from the Section 
Channel into the IMT Draft e-Doc Box [in the General channel] by the lead PIO or their delegate. 
 

Strategize with DOCL or PSC on getting records into the e-Doc box. Examples include selecting a 
date at which older records can be moved by the DOCL into the e-Doc box; drop records into a 
“To Be Filed” folder; coordinate scanning and uploading paper ordering records. 
 

All records must follow the naming convention standards. Rename a file by clicking on the circle to 
the left of the filename. Click on the three dots (…) to the right and select Rename. 
 

INFORMATION — {DocType}_{Date:YYYYMMDD}_{DocVersion}_{IncidentNumber:000NNN} 
Ex: 000363 represents the incident number RM-SJF-000363 — found on IAP or resource order 
Only letters & #s — No spaces — 24-hour time — #s AFTER THE DATE multiple docs per day 
 

 

 

PSA_2021MMDD_SmokeOutlook_000NNN (use INFO TYPE as DocVersion) 
 

CloseOrds_2021MMDD_MBRTBOrder275_000NNN (use ORDER NUMBER as DocVersion) 
 

FireRestrictions_2021MMDD_MBRTBOrder275_000NNN (ORDER NUMBER as DocVersion) 
 

InfoSummCommStrat_2021MMDD_000NNN 
 

ContactLog_2021MMDD_Media_000NNN (use PUBLIC, MEDIA, or TRAPLINE as DocVersion) 
 

MediaRelDalyUpdate_2021MMDD_000NNN 
 

NewsClips_2021MMDD_NYTimes_000NNN (use NEWS AGENCY as DocVersion) 
 

PubMtgAgendas_2021MMDD_CentralHS_000NNN 
 

PubMtgNotes_2021MMDD_CentralHS_000NNN 
 

PubMtgBrfs_2021MMDD_CentralHS_000NNN (PUBLIC MEETING LOCATION as DocVersion) 
 

SpecEvntsToursVIPs_2021MMDD_1_000NNN (1,2,3 etch FOR MULTIPLE DOCS PER DAY) 
 

ThnkYouLtrs_2021MMDD_List_000NNN (use KIND OF DOCUMENT DocVersion) 
 

WebPgs_2021MMDD_YouTube_000NNN (use WEBSITE NAME as DocVersion) 
 

Videos_2021MMDD_HeavyEquip_000NNN (use DESCRIPTION as DocVersion) 
 

Photos_2021MMDD_AirOps_000NNN (use DESCRIPTION as DocVersion) 

 

 

General Messages RECEIVED by your unit 
{213}_{SENDER’s UNIT NAME}_{SENDER’s Last Name if known}_{Date Received}_{Incident#} 
Example: 213_OPS_Doe_20210515_000511 
 

UNIT DAILY LOGS — ICS 214 
{214}_{AUTHOR or UNIT NAME}_{Operational Period Start DATE}_{IncidentNumber} 
Example: 214_INFO_20210515_000511 (entire unit daily log / filed in 214 Information) 
Example: 2014_Doe_20210515_000511 (individual unit daily log / filed in 214 Information) 
 

PerfEvalO_SmithJane_2021MMDD_000NNN (Use Last name First Names Doc Version) 
 

Map Product Files https://www.nwcg.gov/publications/pms936/file-naming 
Information not responsible for maps in the e-Doc Box (Reference here for Inciweb File Names) 
{map type}_{page size}_{page orientation}_{current date}_{time}_ {incident name}_{Unit 
ID+ Local Incident ID}_{Operational period if appropriate}.pdf 
 

https://tinyurl.com/pms277
https://tinyurl.com/pioedocbox
https://www.nwcg.gov/publications/pms936/file-naming
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INCIWEB https://tinyurl.com/pioinciweb 
 
□ https://inciweb.wildfire.gov > Login via 

Login.gov or eAuthenticate. 
□ The User Help (home screen) page has 

Newly Released Items (link New Release 
Page in the yellow ribbon). 

□ Click Manage or Shortcuts in black menu 
bar to show/hide submenus. 

□ View the national map, select Home in light 
blue submenu. 

 
SEARCHING FOR… 
□ To search for Incidents and Publications: 

Manage > select Content > search by Title 
> Filter > Select > Edit (in Operations, right 
column). 

□ To search for existing Media files: Hover 
over Content > select Media > Media 
library. Or select Content > Media tab > 
Search Media name. Choose, Edit from the 
Table view or the Pencil icon (top right of 
media) in the Grid view. 

 
CREATE A NEW INCIDENT 
□ Shortcuts > Group Unit Search/Access > 

Search > choose Unit > Nodes > Add new 
content > Incident. 

□ A red Astrix signifies a required field. 
□ Do not put the date in the title. 
□ Latitude / Longitude is in Deg, Mins, Secs. 

Don’t add special characters (degrees, 
negatives) Seconds out one decimal place. 
Ex. Latitude: 33° 17’ 37” enter as Degrees: 
33, Minutes: 17, and Seconds: 37. 
Long: -110° 27’ 22” enter as Degrees: 110, 
Minutes: 27, and Seconds 22. 

□ Lat/Long Converter 
https://fcc.gov/media/radio/dms-decimal. 

□ Remember: Media can only be attached to 
an incident if it’s already uploaded to the 
media library. If it isn’t, save your work, 
follow steps in Add Incident Media > 
reopen the incident > attach media > Save. 

□ All Incident and Social Media URLs must 
start with http:// or https://. 

□ Ensure incident is marked both Active and 
Published. 

 
ADD an INCIDENT PUBLICATION 
□ (Same as create new incident) from Nodes 

> Add new content > Incident Publication 
> Fill-in all red Astrix > Save (Use NWCG 
Standards). 

□ Document File Size: 256 MB limit. 

□ Document Allowed Types: jpeg, jpg, gif, 
png, txt, doc, docx, pdf, kml, kmz, or rtf. 

□ To post a future publication use 
Scheduling Options (right side). 

□ If wanting to Highlight a publication use 
Highlighted on Home (right side). 
Remember to Unhighlight, if no longer 
needed. A maximum of 3 Incident 
Publications can be highlighted on the 
Incident page. 

□ You can distribute an Incident Publication 
to more than one incident. 

□ Cloning (upper tab) is the duplication of an 
existing publication to edit and republish 
anew. Change title > remove date > Edit 
content > delete Clone of in title > Save. 

 
ADD CONTACTS or COOPERATORS to an 
INCIDENT 
□ Nodes > Create New or Edit an Existing > 

(right side of form) Contact Name can be a 
person, office, location, etc. 

□ Cooperators are unique to the incident. 
□ To prioritize Cooperators, Contacts, and 

Links (can add as many as needed), Grab 
and hold the symbol (on left side) to move 
up or down > Save. 

 
ADD INCIDENT MEDIA ITEM 
□ Manage > Content > Media > Add Media > 

Incident Media Item. Media types (256 MB 
limit on all media types). 

□ Map: upload image and PDF file. 
□ Photo: can only upload one at a time. 
□ Picture File Size: 256 MB limit. 
□ Picture Allowed Types: png gif jpg jpeg. 
□ Video: Only mp4 Standard Definition. 
□ Video File Size: 256 MB limit. 
□ Important: Remember to complete 

Alternative Text > Check ‘I agree’ > add to 
an existing incident > Save. 

 
GROUP RELATED INCIDENTS 
□ Coordinate with ICs, IMTs, and/or Agency 

Administrator before modifying incident to a 
Complex or Area Command. 

□ Manage > Structure > Taxonomy > 
Incident Groups > +Add Term > Name the 
new Group > Group Type > Save. 

□ Open incident to Edit > after incident name, 
use ( ) brackets to name Complex or 
Command > go to Incident Group (right 
column) type in saved Group > Save. 
Repeat if needing to add other incidents to 
the same Group. 

 

https://tinyurl.com/pioinciweb
https://inciweb.wildfire.gov/
https://fcc.gov/media/radio/dms-decimal
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REDIRECT an INCIDENT 
□ Locate Incident > Edit > Scroll to bottom of 

page > uncheck Active > Type Incident into 
Redirect Incident to > Save. 

□ To remove a Redirect > Edit Incident > 
Clear the incident in the Redirect Incident 
field > if needed, recheck the Active box. 

 
COMPOSE an X message 
□ Select X menu bar > Select Incident (drop 

down arrow) > Enter Message > X (280-
character limit including auto-generated 
hashtags). 

 
ADD NEW USER and MANAGE ACCESS 
□ Only Superusers can add new users by 

granting access to their Unit (the user must 
already have an active account). 

□ New: Manage > People > Add User > 
Populate fields > set Roles > Create new 
account. 

□ Existing: Shortcuts > Group Unit 
Search/Access > select Unit > Members > 
Add member > User > Roles (unmarked 
box is a User, marked box is a Superuser) 
> Expiration Date (length of assignment to 
this Unit) > Save. 

 
CONFIRM YOUR UNIT ACCESS 
□ Shortcuts > User Help > Scroll down to 

Unit Member List > Search by Unit 
Members or Parent group > Apply or 
Members. Edit as needed. 

□ Contact a Superuser to request access for 
the unit you’re working on. 

 
INCIWEB SUPERUSER LOOKUP 
□ Shortcuts > User Help > Scroll down to 

Superuser Lookup > Chose a Unit > Filter. 
 
NEEDING HELP WITH INCIWEB 
□ Shortcuts > User Help 

https://inciweb.wildfire.gov/user-help (URL 
only works if logged in). 

□ If you have any questions or encounter an 
error, on the User Help (Welcome) InciWeb 
homepage are links to helpful resources. 
Contact the IIA HelpDesk by phone at 1-
866-224-7677 to resolve. The Helpdesk is 
available 24-hours, 7-days weekly, 
including holidays. 

 
 
 

PRACTICE INCIDENT 
□ Login to Inciweb > Select the Inciweb 

Practice Site link (underlined blue) next to 
the check mark on the right side of screen. 

□ Page switches to practice site map > 
Select Login > next page the top menu bar 
will turn neon green confirming you’re in 
the Practice Site. 

□ If your access has timed out, you may have 
to login or eAuthenticate again. 
 

PUBLIC SITE — STATE VIEW/LIST 
□ Search by State: inciweb.wildfire.gov > 

Help > Links to Individual States. 
□ Table View: inciweb.wildfire.gov > Incident 

Table View > Search by Incident Name or 
State. 

 
PUBLIC SITE — INTERACTIVE MAP 
□ inciweb.wildfire.gov > Search for Incident. 
□ Use +/- icons to Zoom in/out or use 

mouse scroll feature. 
□ Click on cog wheel to change background 

map (topo, aerial, aerial labeled, or roads). 
□ Click the funnel icon to filter incident type. 
□ Click the locator icon to zoom to your 

location. 
□ Click the left arrow icon to go back to 

default view. 
 

PAUSE Before Posting 
 

• PERCEPTION — You are representing the 
jurisdictional agency and your home unit. 
• AUTHORITY — Be aware of federal and 
host agency social media policies. 
• UNDERSTANDING — Know the incident 
objectives. Never post negative, 
controversial, or unsafe messages to 
personal accounts. Ask a PIO/PAO or 
supervisor for clarification. 
• SAFETY — Do not compromise your safety 
while taking photos and always wear proper 
PPE. Never post photos of children, inmates, 
investigations, or cultural sites; be sensitive to 
burned structures and private information. 
• EXPECTATION — Share relevant content 
or photos with PIOs/PAOs to help tell the 
incident story. Source NWCG IRPG PMS 461 
 
 
 

 

https://inciweb.wildfire.gov/user-help
https://inciweb.wildfire.gov/
https://inciweb.wildfire.gov/
https://inciweb.wildfire.gov/
https://www.nwcg.gov/publications/461
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PHOTO / VIDEO TIPS 
 

DISCUSS WITH HOST PUBLIC AFFAIRS 
 File name / caption / credit standards. 
 Where to post photos—Inciweb, Flickr, etc. 
 File storage / transfer—FireNet, Pinyon? 
 Copyright permissions / photo release form 

to license a non-public domain image. 
 Minor release form signed by parent or 

guardian for photos of children. 
 Need for contract photographer / 

videographer? nifc.gov > Fire Info > PIO 
BB > PIO Contacts > contact FS or BLM. 

 
RESIZE PHOTOS IN WINDOWS PHOTOS 
 Open the image you want to resize using 
  the Photos app on a Windows PC (Right 
  click image > Open With > Photos). 
 Click on the “…” > “Resize”. 
 Choose an option or choose custom. 
 Enter a file name > Save. 
 
PHOTO PROPERTIES IN SHAREPOINT 
 From Teams Information channel > Click 

“Open in SharePoint” on header bar. 
 Double Click on an image to preview > 

Click the forward icon to advance (preview 
only works in SharePoint, not in Teams). 

 Click “I” in a circle icon > double click in a 
field to edit file name, title (enter 
caption/photo credit), and (optional) tag 
(followed by enter). 

 
RENAMING IN WINDOWS EXPLORER 
 Open folder with selected images. 
 Right click on image > Rename. 
Batch Renaming in Windows Explorer 
 Open folder with images > Click “Home” 

tab > Click an image, hold down the CTRL 
or SHIFT key then click to select multiple 
images in a folder > Click “Rename” > 
Type file name then press ENTER (will 
rename images New Name (1), New Name 
(2), etc.). 

 
USFS PHOTO NAME 
 Save with filename: yearmonthday-FS 

(Forest Service)-photographer’s initials-# 
sequence. (Ex: 20230101-FS-DC-0101). 

□ For searchability on Pinyon/Flicker/Etc. use 
Filename: One-to-five-word description, 
dash, and number sequence (Ex. Wildfire-
Umpqua-001). 

PHOTO CAPTION METADATA 
A photo caption provides context of the 
photograph to include the who, what, where, 
when, and why. The caption should be added 
to the metadata of the photo, usually in the 
Title or Description field. 
 
WINDOWS EXPLORER PHOTO CAPTION 
 Select image > Select the “View” Tab > 

“Details” View > Click on “Details Pane”. 
 Double click in “Title” field to add caption 

to include what is going on, where, and 
photo credit Example: “Firefighters at 
Thomas Fire, Ventura, Los Padres National 
Forest, California, 2017. USDA Forest 
Service photo by Kari Greer.” > “Save”. 

 
PHOTO CREDIT METADATA 
Proper crediting of images avoids improper 
copyright usage and potential lawsuits. The 
byline should be added to the metadata of the 
photo, usually in the Title or Description field. 
 
USFS BYLINE STANDARDS 
A byline is the photo credit and name of the 
photographer. Example: [Organization] photo 
by [Name of Photographer]. 

 

1. If the photographer is a Forest Service 
employee, write the byline as USDA Forest 
Service photo by Tanya Flores. 
 

2. If the photographer is a non-Forest 
Service Government employee, use the 
agency name. Write the byline as USDA 
photo by Lance Cheung or Bureau of Land 
Management photo by Bob Wick. 
 

3. If the image is legally purchased or 
licensed, write byline as Licensed photo by 
John Smith/iStock photos or Licensed photo 
by Janice Jackson/Associated Press. 
 

4. If a photographer or organization 
donates a photo for official use, write 
byline as Courtesy photo by John C. Smith. 
also, Courtesy photo by Northwest University. 
Do not add donated photos to Flickr unless 
have written permission for public domain. 
 

5. If the photographer is not identified, but 
is a Forest Service image, write the byline 
as USDA Forest Service photo. 
6. If you don't know the origins of a photo and 
don’t have permission to use it, do not use it. 
7. Do NOT use AI generated photos, ever. 

https://www.nifc.gov/fire-information/pio-bulletin-board/contacts
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SAVING MAPS FROM FTP 
https://ftp.wildfire.gov >Incident Specific Data 

> double click on appropriate GACC 
> double click on appropriate folder for 
current year incidents (skip this step if fire 
names are listed in this folder) 
> double click on incident name 
> double click on “GIS” 
> double click on “Products” 
> double click on folder with current date 

- Right click on the file you want to save 
- Select “Save Link As” and save it to your 

desktop or somewhere you can find it 
 
SAVE a PDF as a JPG 
 SCREEN CAPTURE: Windows logo key + 

Shift + S to snip and save what’s on screen 
 Or double click on the PDF > “Edit” > 

“Copy File to Clipboard” > “File” > “Exit” 
 Click on the “Start” Menu, “All Programs” > 

“Accessories” > “Paint” > “Edit” > “Paste” 
 Then click “Crop” in the toolbar > “File” > 

“Save As” > Rename the file to something 
relevant like CubComplexBriefingMap_07-
07-08 > Click on the down arrow to change 
“save as type” to “jpg” 

 Click on the down arrow to change the 
“save in” location to the desktop or 
appropriate folder > “Save” 

 
VIDEO EDITING 
https://tinyurl.com/piovideography 
 Type “video editor” into Windows search 

bar or open the app from the Start menu 
 Select new video project 
 Name your video and select OK 
 Select “Add” then the location you want to 

add photos or videos from 
 Drag photos and videos to your Storyboard 
 After you’ve organized your Storyboard you 

can change the look and feel of each 
 Select a photo or video 
 Select “Duration” to change length (or 

select multiple photos at once) 
 Select “Trim” or “Spit” for editing video 

clips, or “Text” or “Motion” for photos or 
video clips 

 Select a photo or video, then select “text” 
to type a title or phrase 

 When you’re done select “Finish Video” 
and “Export” to publish your film 
 

 

VIP VISIT 
 USFS: Notify WO, Fire Desk & NIFC 
 Who to invite? Work with AA, IC & PAO 
 Invite them to visit & provide incident info 
 Notify the IC and security manager 
 Confirm departure and return times 
 Confirm specific areas the tour will cover 
 Arrange for appropriate vehicles(s) 
 Arrange aircraft with air ops branch director 

(Note: federal law restricts use of public 
aircraft for this purpose) 

 Assign a tour guide who knows the area 
and can answer questions 

 Provide all appropriate safety gear 
 Arrange for lunch / water 
 Provide tour guide with a list of the 

dignitaries’ proper names and titles 
 Security provided? By Whom? 
 Expect a group of assistants to arrive with 

each dignitary 
 Prepare briefing packet(s) 
 
PRESS CONFERENCE 
 Get the IC’s approval. 
 Contact the dignitary’s press person and 

involve in the planning. 
 Establish a facilitator with maps. 
 Select the site, considering: 
 Close to the action without interfering in 

the operation. 
 Room for cameras, light stands, 

microphones, satellite truck parking. 
 Speakers should be on a riser where 

they can be seen and photographed. 
 Consider what is behind the speaker, 

(ex, a window would glare on TV). 
 Access to power for PA equipment. 

 Notify the media of the time, place, and 
purpose of the briefing and who will be 
speaking. Include a contact name and 
phone number. 

 Prepare handouts and maps with current 
info on the incident and an agenda with the 
names and titles of the speakers. Distribute 
to the media as they arrive. 

 A facilitator should announce the purpose 
of the news conference explain any ground 
rules and introduce each speaker. That 
person should keep the briefing moving 
and coordinate questions and answers 
after the speakers are finished. 

 Remember every mic is a live mic. 

https://ftp.wildfire.gov/
https://tinyurl.com/piovideography
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COMMUNITY MEETING 
https://tinyurl.com/piocommunitymeeting 
 
MAKING ARRANGEMENTS 
□ Contact names & phones? Facility 

administrator and on-site setup contact. 
□ Submit name and contact info and details on 

what we’ll be using and how often on General 
Message to ORDM for land use agreement. 

□ What time can we get in to setup? (ideally 2 
hours ahead of time) and/or test in advance? 

□ Formal name of facility? Street Address for 
GPS? Or instructions on how to get there? 

□ Travel Time from ICP? 
□ PA system? Acoustics? Lighting? (test in 

advance if possible). 
□ Projector(s)? Screen(s)? May need an extra 

of each if CART captioning is available. 
□ Where to post hard copy maps? May need to 

order plywood fire info board if needed. 
□ WiFi? Able to access Facebook to 

Livestream? (often blocked on school 
systems) Power source? 

□ Adequate seating? Parking? 
□ Inside/outside? 
□ Backdrop? Facing sun? Background noise? 
□ Overflow contingency? 
□ Map request. 
□ Assign a facilitator (usually a PIO). 
□ Assign PIO(s) to monitor Facebook 

comments. 
□ Coordinate speakers for the agenda and 

forward them the location info & let them know 
to meet 15 min before the meeting starts to 
finalize the agenda and discuss who will 
address anticipated audience questions. 
o Ops 
o IC 
o County Sheriff’s Office 
o County Emergency Management 
o Air Quality 
o Host Unit(s) 

NOTIFICATIONS 
 C&G — especially IC, OPS, LIOF 
 AA, AREP, PAO from host agencies 
 Partner land management agencies 
 Law enforcement 
 Elected officials — local, state, US 
 Permittees 
 Joint Information Center (JIC) 
 MAC Group 
 Area Command 
 Red Cross 
 Inciweb/social media/trapline/daily update 

VISUALS 
 Map Request — E size or BAM to post on 

stage, an electronic version to projects, and 
one or two E size to post on side of room. 

 Ensure map shows distance to the community 
where the meeting is being hosted. 

 Consider fire history, progression, IR maps. 
 PowerPoint / photos / videos / posters. 
 Large fire info website and phone #s to post. 
SUPPLIES 
 Maps and electronic files for presentation 
 Wide blue tape or gaffer’s tape 
 Tripod(s) with adapter to hold phone/iPad 
 Fully charged phone/iPad/video camera with 

enough memory and space to record 
 Green laser pointer (more visible online) with 

extra batteries 
 Projector (if needed) 
 Laptop (if needed) 
 Portable PA system (if needed) 
 Staple gun and staples 
 Tape (scotch and masking) 
 Pushpins 
 Staple remover tool 
 Flip charts / markers 
 Extension cord / Surge strip 
 Fire info signs to post outside 
 Water for speakers on stage 
 Case of water & cooler 
HANDOUTS 
 Copies of agendas for speakers 
 Fire maps & updates 
 Fire info business cards or flyers 
 Firewise materials 
 Smoke & air quality information 
 Evacuation, Ready Set Go, and Emergency 

Alert information (Sherriff) 
 Red Cross information 
 If You Fly, We Can’t 
FACILITATION 
□ Thank host facility / contacts 
□ Emergency exits, restrooms, etc. 
□ Acknowledge online viewers and let them 

know you’re monitoring questions 
□ Summarize agenda 
□ Highlight Inciweb, Fire Info #s, etc. 
□ Hold questions until the end 
Analytics & Monitoring 
 Count # attendees in person 
 Count peak # watching Livestream live 
 Monitor Facebook questions 
FOLLOW-UP 
□ Record stats on unit log 
□ Send thank you, as applicable 

https://tinyurl.com/piocommunitymeeting
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 ACTIVITY REPORT 
Date:               Total 

MEDIA                 
Hours staffed                
# interviews, in person                
# interviews, phone                
Translator available (Y/N)                
# escort tours, camp                
# escort tours, line                
Description: Light, moderate, heavy coverage? Local, regional, national, international interest? 
                
COMMUNITY                
# Trapline miles                
# Trapline stops                
# Info boards updated                
In which communities: 
# staffed info locations:                
In which locations: 
# people talked to                
# community meetings                
# people in attendance                
In which locations: 
Translator available (Y/N)                
                
INFO CENTER                
Hours staffed                
# phone calls taken                
# walk-in visitors                 
# written updates                 
Translation available (Y/N)                
# other docs prepared                
Description: 
# camp tours given                
# people on camp tours                
# bulletin boards posted                
# VIPs briefed/escorted                
                
ELECTRONIC MEDIA                
# web pages updated                
Description: 
# social media views                
# social media shares                
# social media reach                
                
                

 
EXECUTIVE SUMMARY 

 
SIGNIFICANT EVENTS 
 
 
CHALLENGES & RESOLUTIONS 
 
 
LESSONS LEARNED 
 
 
MANAGEMENT EFFICIENCIES 
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TRANSITION / CLOSEOUT 
 
TRANSITION PLAN 
 Transition Plan Inputs 
  https://tinyurl.com/piotransition 

- Remaining staff & planned demob 
- Staffing recommendations 
- Info center / trapline locations 
- Schedule of conference calls, etc. 
- Talking points / key messages 
- Recommended tasks 
- Political considerations 
- Contacts 
- Passwords 

 
TRANSITION CLOSEOUT 
 Requests for Recognition 

https://tinyurl.com/piothankyou 
 Request demobs In Advance (specify 

name, O#, date and time of release, 
method of transportation, jetport, and if 
reservation have already been made or if 
you’re requesting they be made) 

 Task books https://tinyurl.com/pioforms 
 Performance Evaluation (ICS-226),    

PIO Performance Criteria: 
- Knowledge of the job 
- Ability to work with others 
- Organizational skills 
- Attitude 
- Safety 
- Leadership 
- Flexibility 
- Obtain necessary supplies 
- Media interaction 
- Community interaction 
- Initiative 

 Work with Plans to Finalize e-Doc Box 
  https://tinyurl.com/pioedocbox 

- Community Relations / PSAs 
- Closure Orders / Restrictions 
- Info Summary / Comm Strategy 
- Media Log / Key Contacts / Traplines 
- Media Relations / Daily Updates 
- Newspaper Clippings 
- Public Meeting Agendas / Notes / 

Briefings 
- Special Events / Tours / VIP Visits 
- Thank You Letters 
- Web Pages / Videos / Photos 
- Unit Logs 
- General Messages 

 

 
AFTER-ACTION REVIEW 

Focus on the ‘what’, not ‘who’. 
 

- What did we set out to do? 
- What actually happened? 
- Why did it happen? 
- What are we going to do next time? 

- Sustain/Maintain Strengths 
- Improve Weaknesses 

 
 
FINAL CLOSEOUT 
 Tear Down Trapline/Boards 
 Final update on Inciweb/social media 
 Final voicemail/forwarding 
 Out of office message/forwarding 
 Cancel Newspapers 
 Cancel Phones/Internet 
 Return Equipment 
 
DEMOB 
 Check on Travel Arrangements 
 Ground Support 
 Supply 
 Time 
 Training Specialist 
 
UPON RETURN HOME 
 Call Dispatch. 
 Update IROC status 

https://tinyurl.com/pioirocresources. 
 Keep a copy of your resource order, fire 

timesheet, and performance evaluation 
for your records. 

 Make a copy of your task book and keep 
it in a safe place in case you ever lose 
the original. 

 Submit your fire timesheet to your home 
unit timekeeper. 

 Submit a travel voucher to your home 
unit travel coordinator; attach a copy of 
your resource order. 

 
POST-SEASON 
 Submit IQCS Responder Update Sheet 

(https://iqcsweb.nwcg.gov/) with copies 
of training certificates, resource orders, 
performance evals, and completed task 
books to your home unit at the end 
of the season. 

 

https://tinyurl.com/piotransition
https://tinyurl.com/piothankyou
https://tinyurl.com/pioforms
https://tinyurl.com/pioedocbox
https://tinyurl.com/pioirocresources
https://iqcsweb.nwcg.gov/
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PIO RESOURCES 
PIO Incident Management Response Roundtable (IMRR) https://tinyurl.com/IMRRPIOOneNote 
FireNet PIO Toolbox https://tinyurl.com/piotoolbox & https://tinyurl.com/pioquickreference 
NIFC PIO Bulletin Board https://www.nifc.gov/fire-information/pio-bulletin-board 
  Agency Info https://www.nifc.gov/fire-information/pio-bulletin-board/agency-information 
  Hot Topics https://www.nifc.gov/fire-information/pio-bulletin-board/hot-topics 
  InciWeb Information https://www.nifc.gov/fire-information/pio-bulletin-board/inciweb 
  PIO Contacts https://www.nifc.gov/fire-information/pio-bulletin-board/contacts 
  Social Media for PIOs https://www.nifc.gov/fire-information/pio-bulletin-board/social-media 
  Training and Qualifications for PIOs 
  https://www.nifc.gov/fire-information/pio-bulletin-board/training-qualifications-pios 
  Working with the Media and Public 
  https://www.nifc.gov/fire-information/pio-bulletin-board/media-and-public 
  Producer’s Guide to Filming 
  https://www.nifc.gov/fire-information/pio-bulletin-board/producers-guide 
  Military Support History 
  https://www.nifc.gov/fire-information/pio-bulletin-board/military-support-history 

Unit Identifiers https://www.nwcg.gov/publications/931 
NWCG PIO Subcommittee https://nwcg.gov/committees/public-information-officer-subcommittee 
Interagency Standards for Fire and Fire Aviation Operations (“The Redbook”) 
https://www.nifc.gov/policies/pol_ref_redbook.html 
See Chapter 7: Safety for info on work/rest, length of assignment, days off, driving policy, Personal 
Protective Equipment (PPE), safety for personnel visiting fires, fireline escort requirements, etc. 
NWCG Standards for Interagency Incident Business Management 
https://www.nwcg.gov/publications/902 
Incident Pay Guidelines, Travel Procedures, How to Fill out Your Crew Time Report (Daily Incident 
Timesheet), your OF-288 (Final Incident Timesheet), etc. Note: PIOs are not eligible for hazard pay. 
Incident Strategic Alignment Process (ISAP) https://tinyurl.com/ISAPinfo 
Situation Report https://www.nifc.gov/nicc/sitreprt.pdf (https://tinyurl.com/HowToReadIMSR) 
National Fire Maps https://www.nifc.gov/fire-information/maps 
Geographic Area Coordination Centers (GACC) Portal https://gacc.nifc.gov 
National Fire Weather https://weather.gov/fire 
NWCG Glossary of Wildland Fire Terminology https://www.nwcg.gov/glossary 
NIMS Basic Guidance for PIOs https://tinyurl.com/nimospiobasic 
Military Use Handbook Chapter 90 Public Info https://www.nifc.gov/nicc/logistics/references.htm  
Firewise https://www.firewise.org and Fire Adapted Communities https://www.fireadapted.org 
Prepare for Wildfires, Stay Safe During, & After a Wildfire https://ready.gov/wildfires 
Ready, Set, Go! https://www.wildlandfirersg.org 
Health Effects of Smoke https://www.airnow.gov/wildfires 
Aviation Recognition Guide https://www.fire.ca.gov/what-we-do/fire-protection/aviation-program 
Post-Fire Resources https://tinyurl.com/postfireresources

   

https://tinyurl.com/IMRRPIOOneNote
https://tinyurl.com/piotoolbox
https://tinyurl.com/pioquickreference
https://www.nifc.gov/fire-information/pio-bulletin-board
https://www.nifc.gov/fire-information/pio-bulletin-board/agency-information
https://www.nifc.gov/fire-information/pio-bulletin-board/hot-topics
https://www.nifc.gov/fire-information/pio-bulletin-board/inciweb
https://www.nifc.gov/fire-information/pio-bulletin-board/contacts
https://www.nifc.gov/fire-information/pio-bulletin-board/social-media
https://www.nifc.gov/fire-information/pio-bulletin-board/training-qualifications-pios
https://www.nifc.gov/fire-information/pio-bulletin-board/media-and-public
https://www.nifc.gov/fire-information/pio-bulletin-board/producers-guide
https://www.nifc.gov/fire-information/pio-bulletin-board/military-support-history
https://www.nwcg.gov/publications/931
https://nwcg.gov/committees/public-information-officer-subcommittee
https://www.nifc.gov/policies/pol_ref_redbook.html
https://www.nwcg.gov/publications/902
https://tinyurl.com/ISAPinfo
https://www.nifc.gov/nicc/sitreprt.pdf
https://tinyurl.com/HowToReadIMSR
https://www.nifc.gov/fire-information/maps
https://gacc.nifc.gov/
https://gacc.nifc.gov/
https://weather.gov/fire
https://www.nwcg.gov/glossary
https://tinyurl.com/nimospiobasic
https://www.nifc.gov/nicc/logistics/references.htm
https://www.firewise.org/
https://www.fireadapted.org/
https://ready.gov/wildfires
https://www.wildlandfirersg.org/
https://www.airnow.gov/wildfires/
https://www.fire.ca.gov/what-we-do/fire-protection/aviation-program
https://tinyurl.com/postfireresources
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INCIDENT-WITHIN-AN-INCIDENT (IWI) PLAN 
https://tinyurl.com/piocriticalincident 

 

Communications will activate the IWI Plan when the initial notification to the RADO occurs. 
 

GREEN Routine 
□ Non-Emergency Incident — Patient has minor injury or illness. 
□ Non-Emergency transportation is through Ground Support, EMT, or an assigned Supervisor. 

Communications does not restrict radio traffic. Coordination of patient status and transportation 
(MIR) information and assessment is communicated through Communications. Per the Medical 
Incident Report (MIR) or IRPG these patients are GREEN Priority 3. 

□ Day/Night: SOF (and/or MEDL, if assigned) will report to Communications. Relevant 
notifications will be made. 

 

YELLOW Priority 
□ Incident/Medical Emergency — Patient has serious injury or illness. Evacuation may be 

delayed if necessary if other IWIs take priority. Communications does restrict radio traffic. 
Coordination of patient status and transportation (MIR) information and assessment is 
communicated through Communications. Per Medical Incident Report (MIR) patient is 
YELLOW Priority 2 

□ Day: SOF (and MEDL, if assigned), IC/DIC, PSC, LSC, OSC, FSC, PIO (AOBD, COMP if 
assigned) will respond. SOF/IC/DIC may release staff given the specific situation. 

□ Night: Communications contacts the SOF (and MEDL, if assigned). C&G members are notified 
and will report at the discretion of SOF/IC/DIC. 

 

RED Urgent 
□ Incident/Medical Emergency — Life-threatening injury or illness. Evacuation needs are 

immediate. Communication does require a clear channel. Coordination of patient status and 
transportation (MIR) information and assessment is communicated through Communications. 
Per Medical Incident Report (MIR) patient is RED Priority 1 

□ Day: OF (and MEDL, if assigned), IC/DIC, PSC, LSC, OSC, FSC, PIO (AOBD, COMP if 
assigned) will respond. SOF/IC/DIC may release staff given the specific situation. 

□ Night: Communications contacts the SOF (and MEDL, if assigned). C&G members are notified 
and will report at the discretion of SOF/IC/DIC. 

□ **In the absence of a declared severity, respond to the incident as a response.** 
 

PURPLE Other, potentially critical incidents 
□ PURPLE examples include, but are not limited to: unaccounted-for incident resources, threats 

to employees, and accidents involving the public that incident personnel respond to not initially 
requiring the use of ICS 206 but requiring IMT response. 

□ SOF, IC/DIC, LSC, SECM, and PSC will proceed to Communication. Appropriate C&G 
members are to be notified. 

 

Injured or deceased individual(s) 
□ Names shall not be used over the radio. 
□ Deceased individuals and their equipment are not to be moved, except to accomplish rescue 

work or to protect the health and safety of others. If there is potential for a serious accident 
investigation, consider leaving the site as undisturbed as possible. 

 

Clear Text 
□ Utilization of clear text should be a priority on all incidents so that common terminology is 

expressed and understood. If an emergency needs to be declared and radio traffic silenced, all 
personnel shall follow “Emergency Traffic” guidelines to clear radio traffic. 

□ The Operations Section Chief, Division Supervisors, or Communication Units shall 
acknowledge the severity of the emergency. Clear text shall be used to identify the situation of 
the emergency: “MEDICAL EMERGENCY”, “FIREFIGHTER TRAPPED”, “FIREFIGHTER 
BURNED”, “FIREFIGHTER MISSING”, to notify all on-scene personnel. Also, the “Location” 
needs to be communicated and could be as simple as “Division Alpha Firing Group.” 

https://tinyurl.com/piocriticalincident
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□ The acronym “Mayday” is used by some fire agencies as a distress signal (hailing call) 
indicating a firefighter is in trouble or signifies emergencies to aircraft. 

 

HEAR GUN SHOTS/ARMED PERSON(S) EXHIBITING HOSTILE BEHAVIOR 
□ Move to Safe Area AWAY FROM EVENT 
□ Notify Incident Communications 
□ Give Location 
□ Provide situation report 
□ Description of subject(s)/vehicle(s) 
□ Number of shots fired 
□ Know location of escape routes, safety zones and gathering point as they relate to an active 

shooter situation. Ask questions about what right looks like for your work location. If something 
doesn’t look right, say something, it probably isn’t. 

□ Fireworks vs. gunshots; think gunshot. 
 

ACTIVE SHOOTER 
□ Move to Safe Area AWAY FROM SHOOTER 
□ Call 911 — then Incident Communications 
□ Give Location 
□ Medical needs: Number of wounded 
□ Description of subject(s)/vehicle(s) 
□ Number of shots fired 
□ RUN Increasing distance between you and a shooter increases your options and decreases the 

shooters options. Run toward cover (cover stops a bullet). 
□ HIDE Concealment vs. Cover — close and lock doors, turn off lights, be quiet, silence cell 

phones, avoid windows, wall thickness? 
□ FIGHT Respond aggressively, hit / throw / bite / punch / kick / etc. Use improvised weapons. 
□ Law Enforcement’s job is to move to the shooter, not to provide care to you, follow LE’s 

directions, KEEP YOUR HANDS EMPTY AND VISIBLE. 
□ IC is responsible for knowing the status and location of C&G, Section Chiefs are responsible for 

knowing the status and location of all their resources. 
 

IRPG Medical Response Procedures https://www.nwcg.gov/publications/pms461 
□ All injuries must be reported to the direct supervisor. 
□ In case of medical emergency, contact incident supervisor or communications dispatcher, and 

use the Medical Incident Report on IRPG page 118. 
□ Medevac is an incident-within-an-incident. One person needs to become the on-scene IC and 

transfer command later if necessary. 
□ Identify the nature of incident, number injured, patient assessment(s), and location (geographic 

and GPS coordinates). 
□ Do not use patient names on the radio. 
□ Determine transport plan (limited visibility or darkness may delay or negate air transport). 
 
IRPG Fatality Procedures https://www.nwcg.gov/publications/pms461 
□ Never broadcast a patient’s name on the radio or release to anyone except authorities. 
□ Do not allow unauthorized picture taking or release of pictures. 
□ Do not move the body unless it is in a location where it could be burned or otherwise destroyed. 

If movement is necessary, mark the body location. Secure accident scene. 
□ Notify IC, who will:- Assign an individual to supervise evacuation in the event evacuation is 

needed, (See Medical Incident Report, IRPG page 118) and secure the scene after evacuation 
is complete. 

□ Assign an individual to get facts and witness statements and preserve evidence, such as PPE 
involved in the incident (helmet, Nomex, chaps, etc.), until investigation can be taken over by 
the Safety Officer or appointed investigating team. 

□ Notify the Agency Administrator.

https://www.nwcg.gov/publications/pms461
https://www.nwcg.gov/publications/pms461
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PUBLIC INFORMATION OFFICER (PIO) IWI CHECKLIST 
 

□ Check with Safety Officer for a copy of the incident specific IWI plan; provide primary and 
alternate public information officer contacts to include in the plan. 
 

Pre-IWI 
□ Develop IWI communication plan with Incident Commander and Agency Public Affairs Officer. 
□ Establish pre-approved statements that can be used as situations unfold (when things are 

being posted to social media, when calls come into the PIO line, etc.). 
 

During IWI (for YELLOW and RED or at the discretion of SOF/IC/Deputy IC) 
□ Public Information Officer to assemble outside Communications or at the established IWI 

meeting area. 
□ Designate an IWI PIO. 
□ Collect pertinent emergency information for public release. 
□ Coordinate information with Incident Commander, Unified Command, Liaison Officer, 

and Agency Public Affairs Officer to prepare talking points, social media, news releases, and/or 
set up press conferences. 

□ If interagency incident, coordinate communication with other agencies as appropriate. 
□ Coordinate with Operations to assign Information Officers to field media inquiries at accident 

scene, medivac site, and liaise with hospital spokesperson when appropriate. 
□ Coordinate with Liaison (if assigned), LEO, and Logistics regarding roadblocks, evacuations, 

and emergency medical locations. 
□ Withholds release of personal information until approved by Incident Commander and/or 

Agency Administrator. 
□ Restrict/Advise media that they should avoid entering the IWI scene until all Operations and 

Investigation activities are complete. 
□ After approval from IC, coordinate with Plans to arrange a briefing for incident personnel. 
□ Provide periodic updates to the PIO section. 
□ Ensure continuity of operation within the PIO section. Order additional staff as needed. 
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INCIDENT-WITHIN-AN-INCIDENT QUESTIONS TO CONSIDER 
 
 

DISCUSS WITH INCIDENT COMMANDER (IC) / AGENCY ADMINISTRATOR (AA) 
- Who will handle info release — Incident or Home Unit? 
- Who will approve info release — IC or AA? 
- What other agencies will be releasing information (Sheriff, Contractors, etc.)? 
- Who will speak for the incident if there is an immediate press conference? 
- What information is confirmed? 
- What information is NOT releasable?  
- If names are withheld, who will know once the family has been notified and tell IC? 
- When the IC decides to release the names, how will information find out? 
- How will families / home units / other people most directly affected be provided with critical 

information? 
- How will incident personnel be notified? 
- How will agency personnel be notified (Safety Manager, Personnel Officer, PAO, 

LE Staff, Aviation Management, Solicitor, Tort Claims Officer, etc.) 
- How will national personnel be notified (agency director, agency administrators, OIG, etc.)? 
- Who will contact WFF Foundation? 
- How will cooperator personnel be notified? 
- How will fire home unit personnel be notified? 
- What is the response for people who want to help? 
- What about specialized help like animal trailers during an evacuation? 

 
 

DISCUSS WITH Agency PAO 
- Does host agency have qualified PIOs locally? 
- Can any nearby incidents loan staff? 
- Bring PAO on-site with PIOs? 
- Need to establish JIC? 
- Need to establish 800 number? 
- Can incident assist cooperators in need of phones, press conference location, etc.? 

 
DISCUSS WITH COMMAND & GENERAL (C&G) STAFF 
- Will incident personnel be authorized to make one short call home using the incident’s cell or 

stationary phones? 
- Are technical experts (safety, aviation, fire behavior, etc.) available and prepared for media 

interviews? 
 

DISCUSS WITH OPERATIONS 
- Media access, including overflights? 
- Potential for press to block access / how to manage? 
- How and when will PIO receive updates? 
- Designate an operations liaison to be available to resolve questions of fact. 

 
DISCUSS WITH PLANS 
- Do any personnel assigned to incident have PIO quals? 
- Need for maps / graphics? 

 
DISCUSS WITH LOGISTICS 
- Additional logistics needs for info function — radios, etc.? 
- Need to establish a media briefing area? 
- Need to establish media-free areas for incident personnel & family? 
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SERIOUS INCIDENT COMMUNICATION CONSIDERATIONS 
 
The official release of information regarding 
serious accidents or fatalities will nearly 
always be a responibility of the local unit. 
 
LEAD PIO (should NOT be unit PAO) 
• Contact AA or IC for an initial briefing 
• Contact Agency PAO 
• Delegate the Command Staff Information 

Officer duties to another qualified 
Information Officer for the Fire Incident. 

• Designate Internal, Media, & Community 
PIOs. 

• Place an order for additional PIO staff. 
• Set up notification process to ensure all 

PIOs / PAOs are notified when talking 
points are updated. 

• Ensure PIOs take frequent short breaks 
• Develop talking points for approval 
• Obtain authorization for all info release 
• Interface with/distribute approved talking 

points to: 
 IC / C&G / Liaison Officer 
 Agency Administrator 

 Agency PAO — request they contact: 
- Regional / national public affairs 
- Agency frontliners — dispatchers, 

receptionists, etc. 
- Agency FOIA Coordinator 

 Incident PIOs 
 Elected Officials 
 Partner agency PAOs / PIOs 

- Sherriff’s Department 
- EOC 
- JIC 
- MAC / Area Command 
- FAA / NTSB 
- FAST / SAIT 
- CISM 

• Brief PIOs with incoming teams 
• Prepare transition plan which 

incorporates follow-up including: 
 Continuing impacts, staff rides, 

visitors, traffic, media, production 
companies, etc. 

 Need for follow-up committee 
 Requests for dedication memorials 

(plaques and statues) 
 Plan for facilitating return visits to the 

incident site by family 
members/survivors/visitors 

 Evaluate public information activities / 
adjust communication plan as 
appropriate 

 Provide updates to family members 

 
INTERNAL LEAD 
• Chase down rumors 
• Interface with operations for updates 
• Update camp boards / spike camp 
• Post paper next to chow line for 

firefighters to write notes to family 
• Prepare for incoming teams / VIPs 
• Prepare briefing packets 
• Designate liaisons/escorts 
• Arrange for transportation 
• Help coordinate press conferences 
• Keep key personnel informed 
• Provide regular updates and contact 

with all internal / family PIOs 
 
NORMAL FIRE PIOS 
• Continue to provide fire info operations 

 
PIO TO WORK WITH FAMILY LIASION 
• Update family before info released to 

media 
• Ask family if they want to talk to the 

media 
• Contact home unit PIOs to help 

coordinate media contacts with families 
back at home 

• Protect the rights of those who do not 
want media contact 

• Prepare condolence letters within 
• 24 hours (coordinate at all levels in the 

agency) 
• Arrange escorts for families, etc. 

 
COMMUNITY LEAD 
• Post approved talking points in 

information center (to be updated with 
approved messages only) 

• Oversee information center operations 
• Provide regular updates and contact 

with all office / community PIOs 
 
COMMUNITY PIOS 
• Update / staff community info boards 
 

OFFICE PIOS 
• Staff info center phones 
• Update website with approved info 
• Periodically check email and monitor 

blogs 
• Prepare thank you and commendations 
• Tasks volunteers: herding, faxing, etc. 
• Maintain documentation file 
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FIELD PIOS 
• Intercept looky-loos and reporters on-

scene, in camp, at hospital, helibase, 
etc. 

• Provide media/ VIP escorts 
• Coordinate media access to accident 

site, overflights, memorial services, etc. 
 
MEDIA LEAD 
• Identify / serve as primary 

spokesperson. 
• Provide regular updates and contact 

with all field / media PIOs. 
• After a fatality: Restrict media access 

until bodies have been removed and all 
families notified. Then provide the 
media with a tour date and time and 
escort them to the scene. 

 
MEDIA PIOS 
• Contact reporters via phone / return 

calls as soon as releasable info 
available / updated 

• Prepare news release(s) for approval 
• Distribute approved news release 
• Prepare photos/bios of victims 
• Arrange press conferences 
• Designate “media-free” space for 

incident personnel 
• Designate media briefing area 
• Consider media needs — phones, work 

areas, parking, deadlines, PPE, photo 
opportunities, interviews, etc. 

• Need for pool photographer? 
• Publicize info phone / website 
• Incorporate key messages 
• Monitor media coverage 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MEMORIAL SERVICE CONSIDERATIONS 
 Set up a hotline with a recorded 

message and/or a website where info will 
be shared as soon as it is available. 

 Embed PIOs in planning effort. 
 Set up an email or phone number for 

RSVPs to help anticipate attendance. 
 Work with family to obtain photos, bios, 

establish a memorial website, address, 
and email to send condolences, 
preferred charity, memorial, and funeral 
service info, etc. 

 Clarify and share information on agency 
protocol regarding travel, admin leave, 
uniforms, use of gov’t vehicles, flag-
lowering, and wearing of black bands. 

 Arrange for photos / video of service. 
 Ensure PIOs are familiar with program: 

names and relations of speakers, where 
the honor guard is from, immediate 
family members’ names, what types of 
aircraft are flying in tribute, etc. 

 Thank you letters for incident personnel, 
flowers, gifts, donations, etc. 
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INCIDENT-WITHIN-AN-INCIDENT — FIRST MESSAGE 
Crisis & Emergency Risk Communication — https://emergency.cdc.gov/cerc/ 

 
1. Expression of empathy 
2. Clarifying facts 
3. What we don’t know 
4. Process to get answers 
5. Statement of commitment 
6. Referrals 

- Provide information to victim/family first. 
- State only facts. Do NOT speculate. Confirm 

the obvious. 
- Document all individual actions on unit log. 
- Restrict radio communications. Share info 

via phone or face-to-face.
 
 

We are aware that an [accident/incident]______________________ involving 

[type of incident]____________________________ occurred at approximately 

[time]______________, in the vicinity of [general location]________________. [Agency 

personnel]_________________________________ are responding, 

And we will have additional information available as we are able to confirm it. 

We will hold a briefing at [location]________________________________, and 

will notify the press at least [time, ie. ½ hour]____________________ prior to 

the briefing. At this time, this briefing is the only place where officials authorized 

to speak about the incident and confirmed information will be available. 

Thank you for your assistance. 
 

Check message for: 
- Positive action steps 
- Honest/open tone 
- “We” not “I” 
- Be careful with early promises 

Avoid jargon 
Avoid judgmental phrases 
Avoid humor 
Avoid extreme speculation 

 

 

RELEASABLE INFORMATION 
- How many people involved / number and type of injuries / number of fatalities 
- What happened / type of accident or incident 
- When 
- Where / location of incident / property owner 
- Response Actions / identification of responding agencies 
Do NOT Release without Agency Administrator permission: 
- Names of Fatality Victims, including juveniles (only after the next of kin are notified). 
- Names of Injured or Missing Victims. 
- Names, ages, home units, and hometowns of the individuals involved in the incident. 
- Crew names, aircraft characteristics or designators, or other identifying info. 
- Description of lost, stolen, or missing property. 
- Criminal charges if applicable. 
Do NOT Release: 
- Home Address, Phone, or Social Security Number 
- Names of Juveniles Charges with Criminal Offenses 
- Names of Victims of Sexual Assault 
- Names of people or witnesses who may become victims of crime or retaliation in the future 
- Information on incidents where criminal action is still under investigation and information 

released could hinder or adversely affect the investigation 
- Investigative information beyond general incident reporting 
- Explicit details, including graphic photos, images of extreme injuries or brutal fatalities 

https://emergency.cdc.gov/cerc/


51 

 

INCIDENT-WITHIN-AN-INCIDENT — FIRST MESSAGE 

Expression of empathy 
- This is an evolving emergency and I know that — just like we do — you want as much 

information as possible right now. I wish I could answer all of your questions here. While we 
work to get your questions answered as quickly as possible, I want to tell you what we can 
confirm right now. 

- Our ___________ (hearts / deepest condolences) go out to the _________ (firefighter’s last 
name) family and friends during this very tragic time. 

- ___________ (firefighter’s name) is a member of our __________ (agency) ‘family,’ and will be 
deeply missed. 

- He/she took on a difficult job, and served our nation well, in the finest tradition of the 
_________ (agency). His/her through his/her dedication, courage, and spirit — will live on in 
the hearts and minds of all of us. 

- Our thoughts and prayers are with _______ firefighter’s name) family, friends, and co-workers. 
 
Clarifying facts (VERIFIED facts only, skip if not certain) 
- On ____ (date) firefighter _________ (name), an _______ (age)-year-old _________ (agency) 

firefighter based out of __________ (home unit) in ___ (state) ________________ (describe 
situation — received multiple injuries yesterday, was killed while ____________ (clearing trees, 
etc.) while working on the _______ (fire name) fire on the ___________ (unit name) in 
___________ (state). 

- We are extremely relieved that no one was apparently injured in this incident. 
- The crew has been taken off the fire pending investigation into the incident. 
- It is with great sadness that we confirm the names of the __________ (agency) firefighters who 

tragically lost their lives while in the line of duty _________ (when). 
 
What we don’t know 
- At this point, we do not know _________________ (# of injuries, # of deaths, cause of 

accident, etc.) 
- All of our efforts are directed at bringing the situation under control, so I’m not going to 

speculate about the cause of the incident. 
 
Process to get answers 
- We have a system (plan, procedure, operation) in place for emergencies such as this and we 

are being assisted by _______ (Sherriff’s Dept. etc.) as part of that plan. 
- We’ve just learned about the situation and are trying to get more complete information now. 
- The accident investigation is ongoing. 
- ____ (park managers, etc.) are working with _____ (Sherriff’s Dept, etc.) to ensure site safety 

and integrity. 
- The ___________ (DOI’s Aviation Management Directorate, etc.) will participate in the crash 

investigation, which is being coordinated with the ____ (National Transportation Safety Board, 
Federal Aviation Administration, etc.). 

- An interagency (DOI, Contractor, FAA, Serious Accident Investigation Team, etc) investigation 
team is scheduled to arrive in _______ (location) ______ (when) to conduct a review of the 
incident. 
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Statement of commitment 
- The situation is ________ (under, not yet under) control and we are working with _______ 

(local, state, federal) authorities to (contain this situation, determine _____ (how this happened, 
determine what actions may be needed by individuals and the community to prevent this from 
happening again.) 

- Whenever injuries such as these occur during firefighting operations, a top priority is to learn 
everything we can about them so we can work to prevent similar incidents from happening 
again. 

- People are our most valuable resource and we remain committed to the safety of our 
firefighters. We cannot forget that there are still _____ (number) firefighters continuing to work 
to suppress fires here in _______ (location). We’ve made great progress, but much remains to 
be done. 

- Our interagency fire teams develop strategies for fighting a fire. Fire managers continue to 
consider fire behavior, weather forecasts, terrain, accessibility, and proximity to communities 
when considering fire suppression strategies. 

- We must consider firefighter safety in all of our tactical decisions. Firefighter and public safety 
will remain our number one concern. 

- As a precaution, all ____________ (aviation, etc.) operations on the __________ (home unit, 
etc.) are discontinued until further notice. 

 
Referrals (if possible, skip if not yet ready) 
- We will continue to gather information and release it to you as soon as possible. I will be back 

to you within ___________ (amount of time, 2 hours or less), to give you an update. As soon as 
we have more confirmed information, it will be provided. We ask for your patience as we 
respond to this emergency. For more information… 

- The name will be released by the ____________ Sheriff’s Department pending notification of 
family members. 

- Next scheduled update… 
- Calls on this incident will be taken starting at 0800 tomorrow morning (date) at the following 

numbers: ___________. 
- How can I reach you when I have more information? 
- I’m not the authority on this subject. Let me have ______________ (name) call you right back. 
- We’re preparing a statement on that now. Can I fax it to you in about two hours? 
- You may check our website for background information and I will fax/email you with the time of 

our next update. 
- Photographs will be made available as soon as possible at _________________________. 
- A fund will be established by the Wildland Firefighter Foundation in ____________________ 

(firefighter’s name) name. The foundation is online at https://wffoundation.org and can be 
contacted by calling 208-336-2996. 

https://wffoundation.org/


53 

 

INCIDENT-WITHIN-AN-INCIDENT FACTS 
BOLD CAPS = RELEASABLE INFO  All other info DO NOT RELEASE without AA approval. 

 
INITIAL REPORT BY:   TO WHOM:   DATE/TIME: 

# PERSONNEL INVOLVED:  # VEHICLES:   # INJURIES:   

# FATALITIES:   # OK:  

WHAT WERE THEY DOING AT THE TIME? 

RESPONSE RESOURCES:      RESPONSE TIME: 

RESPONSE ACTIONS: 

FIRE NAME:     IMT/IC: 
 
HOME UNIT:     LOCATION/STATE: 
 
CAUSE:     START DATE: 
 
# PERSONNEL:    FUELS: 
 
TERRAIN:    WEATHER: 
Name:     Age:    Fireline Position: 
 
TRANSPORT:    HOSPITAL:  LOCATION: 
 
HOSPITAL PAO NAME & PHONE: 
 
INJURIES:   Treatment:  Cause of Death: 
 
Affiliation:    # Members:   Location:  
 
Home Unit:   Agency:     State:  
 
Hometown:   Yrs in Fire: 

EQUIPMENT TYPE:  Name:    Make/Model: 

Damage:    Driver/Pilot:    

TOTAL # ONBOARD:   Names Onboard: 

 

Description of lost, stolen, or missing property: 
 
Criminal charges: 
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CALENDAR (Home Unit Time Due Sunday) 
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KEY CONTACTS 
KEY CONTACTS PHONE CONTACT INFO 
IC 
   

DEPUTY IC 
   
LOFR 
   

  
  

FireNet Helpdesk  incident.helpdesk@firenet.gov 
https://www.firenet.gov/node/2 

Inciweb Helpdesk (866) 224-7677 
https://iiahelpdesk.nwcg.gov 
https://tinyurl.com/inciwebinfo 

Brian Reublinger 
Inciweb Business Lead (775) 772-3426 brian.reublinger@usda.gov 

Remote Incident Support 
Team (RIST) Coordinator (480) 608-2175 rist@firenet.gov 

https://linktr.ee/ristinfo 

Concur Travel (USFS)  (877) 372-7248 x 3 
(800) 877-6120 https://usdafs.connecthr.com 

Concur Travel (DOI) (855) 847-6398 x 4 https://cge.concursolutions.com 
Wildland Firefighter 
Foundation (208) 336-2996 https://wffoundation.org 

info@wffoundation.org  

Disaster Distress Helpline Call or Text 
(800) 985-5990  https://disasterdistress.samhsa.gov 

NWCG Mental Health 
Subcommittee Resources  https://tinyurl.com/nwcgmentalhealth 

NIFC Fire Info 
 

(208) 387-5050 https://www.nifc.gov 
https://tinyurl.com/NIFC-EAContacts 

Samantha Storms 
NIFC BLM Ext Affairs (208) 387-5895 sstorms@blm.gov 
Lessa Peter 
NIFC BIA Ext Affairs (928) 200-1941 lessa.peter@bia.gov 
Tina Boehle 
NIFC NPS Ext Affairs (208) 387-5875 tina_boehle@nps.gov 

Kari Cobb 
NIFC FWS Ext Affairs (208) 387-5508 kari_cobb@fws.gov 
*^Stanton Florea 
NIFC USFS Ext Affairs (208) 387-5437 stanton.florea@usda.gov 

*Isaiah Hirschfield 
National Fire Desk Manager (202) 205-1450 national.firedesk@usda.gov 

isaiah.hirschfield@usda.gov 
*Michelle Burnett 
  USFS WO Public Affairs   michelle.burnett@usda.gov 
^Chad Douglas 
FS WO Acting Director of 
Communications 

 chad.douglas@usda.gov 

*Notify about all federal and non-federal fires of interest to the news media, elected 
officials, and senior USFS and USDA leadership 
^Work with the local or regional USFS PAO to notify about all VIP visits on USFS incidents  

mailto:incident.helpdesk@firenet.gov
https://www.firenet.gov/node/2
https://iiahelpdesk.nwcg.gov/
https://tinyurl.com/inciwebinfo
mailto:rist@firenet.gov
https://usdafs.connecthr.com/
https://wffoundation.org/
mailto:info(a)wffoundation.org
https://disasterdistress.samhsa.gov/
https://tinyurl.com/nwcgmentalhealth
https://www.nifc.gov/
mailto:tina_boehle@nps.gov
mailto:national.firedesk@usda.gov
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KEY CONTACTS 
KEY CONTACTS PHONE CONTACT INFO 
FIRE INFORMATION 
 

  

JOINT INFO CENTER 
(JIC) 

  

HOST UNIT PAO(S) 
 

  

AREA COMMAND 
 

  

AGENCY ADMIN 
 

  

AGENCY REP 
 

  

DISTRICT OFFICE 
 

  

AGENCY WEBMASTER 
 

  

EOC 
 

  

SHERIFF 
 

  

RED CROSS 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

EXPANDED DISPATCH 
# on Resource Order 

  

HOME UNIT DISPATCH 
 

 
 

 

HOME UNIT 
TIMEKEEPER 
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KEY WEBSITES 

 

Disclaimer While the goal is to make this information as timely and accurate as possible, there are 
no claims, promises, or guarantees about the accuracy, completeness, or adequacy of the contents 
of this document. Liability for errors and omissions in the contents of this document is expressly 
disclaimed. No warranty of any kind, implied, expressed, or statutory, including but not limited to 
the warranties of non-infringement of third-party rights, title, merchantability, fitness for a particular 
purpose or freedom from computer virus, is given with respect to the contents of this document or 
its links to other Internet resources. Reference in this document to any specific commercial product, 
process, or service, or the use of any trade, firm or corporation name represent examples for 
information and convenience and does not constitute endorsement, recommendation, or favoring. 
This document does not provide absolute solutions to the unlimited number of situations that will 
occur. Some decisions may be relatively simple; many are not. These decisions often require 
individual judgment, creativity, and collaboration — skills developed through extensive training, 
dedicated practice, and experience, which this document helps facilitate. 
 

WEBSITE USERNAME NOTES 
IROC Overhead Self-Status 
https://tinyurl.com/pioirocresources 

  

FireNet https://www.firenet.gov/ 
https://tinyurl.com/piofirenet 

  

NIFC FTP — Incident Maps 
https://ftp.wildfire.gov/ 

  

FAMAuth / iNAP 
https://famauth.wildfire.gov  

  

Inciweb https://inciweb.wildfire.gov 
https://tinyurl.com/pioinciweb 

  

SIT-209 (Read-Only) 
https://tinyurl.com/pioSIT209 

  

Fire Enterprise Geospatial Portal (EGP) 
https://egp.nwcg.gov/egp 

  

NIFC ArcGIS https://nifc.maps.arcgis.com 
Sign In > Group > Outreach Resources 

  

WFDSS 
https://wfdss.usgs.gov/wfdss/WFDSS_Home.shtml 

  

   

   

   

   

   

   

   

   

   

   

https://tinyurl.com/pioirocresources
https://www.firenet.gov/
https://tinyurl.com/piofirenet
https://famauth.wildfire.gov/
https://tinyurl.com/pioinciweb
https://tinyurl.com/pioSIT209
https://egp.nwcg.gov/egp/
https://nifc.maps.arcgis.com/
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